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CHAPTER 1: INTRODUCING TIMBUKTU PRO

Welcome to Timbuktu Pro for Windows™!

Timbuktu Pro for Windows gives you total access to your network. Computers
across the country and around the world—Windows and Macintosh—are now as
accessible to you as the computer sitting on your desk! You can use Timbuktu Pro
to control and observe other computers, send instant messages, transfer files,
and text-chat or speak with remote users in real time. And Timbuktu Pro for Win-
dows offers direct modem-to-modem connections between computers—with no
network connection required.

TIMBUKTU PRO SERVICES

The simple but powerful Timbuktu Pro interface provides you with the following
services:

Send lets you send messages with attached files and folders to a remote
computer.

Exchange lets you access the hard drive of a remote Timbuktu Pro computer—
even a Macintosh. You can copy and move files and folders between
computers and delete files from either computer.

Control lets you control a remote computer from your own desktop.

Observe lets you observe a remote computer without controlling it.

Notify alerts you when a remote Timbuktu Pro computer becomes active.
Chat lets you carry on a keyboard conversation with a remote user.

Intercom lets you speak directly to a remote user through your computer’s
audio hardware.

Invite allows you to invite other users to access your computer using the Tim-
buktu Pro service you specify.

17
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CONNECTING WITH TIMBUKTU PRO

When you’re at the office, Timbuktu Pro runs over your company’s local area net-
work (LAN) for easy conferencing and information sharing. When you’re home or
traveling, you can log on to a remote access server and use Timbuktu Pro to take
direct control of your office computer. You can even use your modem to dial di-
rectly into the modem of another computer, with no network connection required.

Once you connect to a remote computer with Timbuktu Pro, you can run “LAN-
locked” software at its normal speed, dramatically decreasing over-the-phone de-
lay of applications such as relational databases and electronic mail. Timbuktu Pro
gives you full access to remote resources, but transfers only screen, keyboard,
and mouse information—you don’t have to move large amounts of data over slow
telephone links.

Timbuktu Pro uses a flexible and comprehensive security scheme. You can spec-
ify many different levels of access for remote connections to your computer: you
may allow all guests access to some services, while limiting other services to spe-
cific users that you define, and admitting still other users and granting services
on a case-by-case basis. You can even prevent remote users from connecting to
your computer entirely.

How DoOES IT WORK?

Timbuktu Pro communicates with other Timbuktu Pro computers over TCP/IP
(Transmission Control Protocol/Internet Protocol) networks or through direct
modem-to-modem connections.

You can use Timbuktu Pro to access other computers or to provide remote access
to your own PC. Timbuktu Pro can work in both directions at once: another user
can send files to you while you are controlling or observing a third computer.

Timbuktu Pro runs in the background of your Microsoft Windows computer. Instal-
lation takes only minutes. Timbuktu Pro is non-intrusive; it doesn’t replace your
video, mouse, or keyboard drivers.

Timbuktu Pro works overyour LAN, WAN (Wide Area Network), DSL, cable, dial-up,
or ISDN (Integrated Services Digital Network) lines. You can use Timbuktu Pro for
file transfer, remote control, and message exchange with other Timbuktu Pro com-
puters anywhere in the world.
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WHAT TimBUKTU PRO CAN DO FOR YOU

With Timbuktu Pro, you can

e Support end users from your desk. Save technical support time and money
when you use remote control to solve user problems. Take control of a remote
user's computer and solve the problem without even leaving your chair.

e Train employees and customers alike for a fraction of the usual time and cost.
Demonstrate the latest applications, databases, and specialized products
while a remote user watches. Then observe and help as the user practices.
Provide individual attention for all remote trainees, and save the time and ex-
pense of travel.

e Work remotely from wherever you are. Harness the power of remote control to
share information, transfer files, read electronic mail, access databases, and
send quick messages across your network. You’ll discover many ways to work
easier and smarter.

®  Run “LAN-locked” applications easily. End the frustration of slow run-time
over remote links for network applications such as databases. Because the
applications run only on the remote computer, and not across telephone
lines, you’ll speed up processing time dramatically.

e Collaborate with remote colleagues in real time. Share screens, documents,
and information. Work with others anywhere, and confer with your colleagues
using audio- or text-based conferencing.

e Protect your network resources. You can grant varying levels of Timbuktu Pro
access to different users. Registered User and Windows NT User accounts and
passwords can protect any combination of Timbuktu Pro services.

WHO CAN CONNECT TO YOUR TIMBUKTU PRO COMPUTER?

The first and most important answer is “No one—without your permission!” But
once you have set up your security options, anyone who meets your connection
criteria may connect.

If your computer is connected to a company network that is protected by a fire-
wall, your Timbuktu Pro computer may only be accessible to users from your local
network. However, firewalls can be configured to admit Timbuktu Pro traffic.
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TIMBUKTU PRO FEATURES

Timbuktu Pro’s rich feature set lets you work with remote computers—and remote
users—more efficiently and securely than ever before. Remote control capability;
Dial Direct, LDAP, Internet Locator, and TCP/IP Scanner features; enhanced secu-
rity: Timbuktu Pro is packed with features to make your network work for you.

NEW IN TIMBUKTU PRO VERSION 8

Timbuktu Pro version 8 takes full advantage of the Internet as well as the most re-
cent improvements and features available in the Windows OS. You will benefit
from the latest file sharing and collaboration service refinements. Timbuktu Pro
version 8 makes use of SSH to provide both enhanced security and improved per-
formance. Plus, Timbuktu Pro version 8 includes a number of new features to
make it easier than ever for you manage your files across the network and collab-
orate with remote users.

STREAM ENCRYPTION AND COMPRESSION

Timbuktu Pro version 8 supports SSH to encrypt and compress Timbuktu Pro con-
nections. When you begin a remote connection, you will have the option to select
SSH encryption and enter the credentials that allow you to securely access the re-
mote computer.

In addition to providing secure connections, SSH compression may increase Tim-
buktu Pro performance.

ENHANCED SCREEN-SHARING PREFERENCES

In Timbuktu Pro version 8, the Observe/Control tab in the Preferences window has
been separated into two tabs: Observe/Control Host and Observe/Control Guest.

The two new tabs provide a number of new options, each of which may increase
the performance or security of your screen-sharing sessions.

In addition, the screen-sharing window’s system menu has been expanded to in-
clude a number of new options. You can control settings for the screen-sharing

window itself, or choose the Host Settings option to open a dialog box with many
of the new guest computer screen-sharing options. With the Host Settings dialog
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box, you can change your guest preferences on the fly, during an active screen-
sharing session.

EXTENDED LOGGING
The logging capabilities in Timbuktu Pro have been dramatically enhanced.

Timbuktu Pro now supports two different types of centralized logging for all the
Timbuktu Pro computers on your network:

e The Timbuktu Log Server allows you to copy information from your Timbuktu
Pro activity log or Event Log file to another Timbuktu Pro computer.

e The NT Event Log Server allows you to copy information about Timbuktu Pro
events from your Windows Application Event Log to the Application Event Log
on another Timbuktu Pro computer.

In addition, you may create an Event Log file, a text document which records the
same information that Timbuktu Pro records in the Windows Application Event
Log. The text file format allows you to easily search the log for events you wish to
review.

You may also now specify the maximum size for your log files, and you may spec-
ify that certain configuration changes are recorded in the log files.

To set up your logging options, use the new Logging tab in the Preferences dialog
box.

SINGLE-STREAM CONNECTIONS

Timbuktu Pro now uses single-stream TCP connections by default. If you are run-
ning Timbuktu Pro through a firewall, you now need to open port 407 only.
Service-specific ports are no longer required unless you are connecting to an
older version of Timbuktu Pro.

MSI INSTALLER

Timbuktu Pro now uses a Windows MSI installer with a user interface, which al-
lows you to set certain options during installation.
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TIMBUKTU PRO SERVICES

Each of Timbuktu Pro’s services allow you to interact with remote computers in a
different way; together, they help you make the most of your network. For details
about the various Timbuktu Pro services, see “Chapter 5: The Timbuktu Pro Ser-
vices.”

REMOTE CONTROL AND SCREEN-SHARING

Control a remote computer anywhere on your network using Timbuktu Pro’s
IntelliScreen™technology. Timbuktu Pro’s Control and Observe services provide a
powerful tool for user support, training, and collaboration. Timbuktu Pro automat-
ically adapts to any video mode.

The AutoScroll™ feature offers automatic panning as you move your pointer on
the remote desktop. Thus, you can always view the entire screen of the remote
computer, even when monitor resolutions are different. Or you can use the Shrink
to Fit option to automatically reduce the remote desktop so that it fits entirely
within the screen-sharing window. If you resize the screen-sharing window, the
view of the remote desktop is also resized.

Plus, with the Capture Frame option, only the portion of your desktop that ap-
pears in the Capture Frame is displayed in the screen-sharing window on the re-
mote computer.

In addition to the Capture Frame and Shrink to Fit features, the screen-sharing
window includes several additional features to assist you:

e It supports a mouse wheel and extra mouse buttons.

e When you control a remote computer, you can choose to force its CAPS LOCK,
NUM LOCK, and SCROLL LOCK states to match your computer’s settings.

¢ You may choose whether keyboard mapping is performed logically or physi-
cally. For example, if the host computer uses a Qwerty keyboard and the
guest computer uses a Dvorak keyboard, logical mapping allows you to press
the y key on the guest computer with the same effect as pressing the Y key on
the host computer.

SEND—SENDING MESSAGES

Use the Send service to send FlashNotes™—instant messages that pop up on the
recipient’s desktop—to other Timbuktu Pro users. You can attach files and folders
to your FlashNotes, transferring them across your network quickly and easily.
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EXCHANGE—FILE TRANSFER

The Exchange service makes transferring files between computers easy. Use it to
copy, move, and delete files across the network—even on Macintosh computers!
The Exchange window makes the remote computer’s file system as accessible as
your own.

NOTIFY, CHAT, INTERCOM, AND INVITE

Communicating with other Timbuktu Pro users is more convenient than ever with
Timbuktu Pro’s Notify, Chat, Intercom, and Invite services. Notify alerts you when
a remote computer becomes active. Chat allows you to have a keyboard “conver-
sation” with another user. Intercom lets you have a voice conversation using your
microphone and speakers—no telephone required. Invite allows you to invite
other users to access your computer using the Timbuktu Pro service you specify.

OTHER TIMBUKTU PRO FEATURES

In addition to the enhancements in Timbuktu Pro version 8 and the Timbuktu Pro
services, all your favorite tools and features from previous versions are available.

COMPREHENSIVE MULTI-LEVEL SECURITY

You can restrict remote access to your computer to as few or as many remote us-
ers as you wish. Anyone can access the services you provide to Guest Users. You
can define any number of Registered Users and Windows NT Users, who will have
password-protected access to the specific combination of user access privileges
you specify. And if you wish to grant one-time-only access to other Timbuktu Pro
services, remote users can ask for permission to use services you have not as-
signed. If you choose OK, they’re connected. If you don’t, they aren’t. For tightest
security, you can even require Registered Users and Windows NT Users to ask for
permission after they’re authenticated.

SHORTCUT MENU

The Timbuktu Pro shortcut menu lets you quickly open Timbuktu Pro and monitor
incoming connections. When a remote user connects to your computer, the Tim-
buktu Pro icon in the system tray on the taskbar alternates with a service icon in-
dicating that a service is in use. For a list of Timbuktu Pro service icons, see “lcon
Legend” on page 103.
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CROSS-PLATFORM CONNECTIONS

Timbuktu Pro offers remote control and file transfer between Windows and Macin-
tosh computers. From a PC or a Macintosh, you can remotely control a computer
of either type as if you were seated in front of it. Timbuktu Pro also provides
cross-platform file transfer with a convenient, one-step procedure. You can even
customize your cross-platform file-mapping settings so that Windows file exten-
sions and Macintosh Type/Creator settings are applied automatically.

DIAL DIRECT CONNECTIONS

Timbuktu Pro’s Dial Direct feature allows you to use your modem to connect di-
rectly to the modem of another Timbuktu Pro computer. No Internet connection is
required. You can use any of the Timbuktu Pro services, except Intercom.

FINDING REMOTE COMPUTERS

Timbuktu Pro includes several different methods for finding remote Timbuktu Pro
computers on your network.

The Internet Locator Server

The Internet Locator feature allows you to connect to other Timbuktu Pro users by
specifying their email addresses instead of their IP addresses. When you enter
an email address on the TCP/IP tab in the main Timbuktu Pro window, Timbuktu
automatically queries Netopia’s Internet Locator server, resolves the correct IP
address, and connects to the remote computer.

LDAP Searches

Timbuktu Pro’s LDAP (Lightweight Directory Access Protocol) support allows you
to easily find and connect to other computers running Timbuktu Pro, without
knowing their IP addresses. Instead of entering a remote user’s IP address, you
can use the LDAP tab to search for other LDAP-enabled Timbuktu Pro users by
their user information. Search strings include computer name, IP address, user
name, email address, location, and comment. You can also store your own infor-
mation to enable other users to find you. User information is stored on Netopia’s
public LDAP server.
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Timbuktu Pro Scanner

The Timbuktu Pro Scanner helps you find and connect to remote computers, even
when you don't know their IP addresses, by browsing your local network for active
Timbuktu Pro computers. You may even connect to the desired computer without
leaving the Timbuktu Pro Scanner.

TIMBUKTU PRO CONNECTION DOCUMENTS

Timbuktu Pro Connection Documents are desktop shortcuts that allow you to acti-
vate a Timbuktu Pro service to a remote computer from a desktop icon. To quickly
create a desktop shortcut, right-click anywhere on your desktop. From the short-
cut menu, choose New » Timbuktu Pro Connection Document.

Once you’ve created a Connection Document, right-click it to display a shortcut
menu. The menu allows you to rename your Connection Document, change its
properties, or delete it.

NETWORK NEIGHBORHOOD/MY NETWORK PLACES

Timbuktu Pro’s Network Neighborhood/My Network Places integration gives you
immediate access to remote computers without opening the main Timbuktu Pro
window. In the Network display, right-click on any computer. From the shortcut
menu, choose Timbuktu Pro » Any Service. You can launch any Timbuktu Pro ser-
vice, as long as the remote computeris running Timbuktu Pro and uses the TCP/IP
protocol.

ADDRESS BOOKS

Use Timbuktu Pro’s address books to help you organize the IP addresses of the
remote computers you connect to frequently. An address book is a collection of
Timbuktu Pro addresses. They save you time because you don’t have to enter an
IP address every time you make a connection—simply select a computer from the
list.

RECENT CONNECTIONS

The Recent Connections tab contains a list of computers to which you’ve recently
established connections. The default service (the service that was used during
the previous remote connection) is also saved. Simply double-click an address to
reconnect.
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ACTIVITY LOG AND APPLICATION EVENT LOG

Timbuktu Pro keeps a list of all connections made to and from your computer. You
can display the activity log or save it to a text file for printing. Timbuktu Pro also
logs guest and host service events to the Windows Application Event Log.

SYSTEM REQUIREMENTS FOR TIMBUKTU PRO

To run Timbuktu Pro for Windows, your computer must meet the following hard-
ware, software, and compatibility requirements.

MINIMUM HARDWARE REQUIREMENTS

Timbuktu Pro requires 20MB of free disk space for installation. 5o0MB are required
for the network installation process.

If you wish to make a Dial Direct connection using Timbuktu Pro, you will need a
56 Kbps modem.

MINIMUM SOFTWARE REQUIREMENTS

e  Windows 2000, Windows XP, or Windows 2003 Server.

e TCP/IP networking software that is installed and properly configured.

e For Dial Direct connections, modem software that is installed and properly
configured. Dial Direct connections use the TCP/IP protocol, so network soft-
ware is still required.

COMPATIBILITY

e ForTCP/IP connections, the remote computer must be on a TCP/IP network
and be running Timbuktu Pro for Windows version 5.0 or later, or Timbuktu
Pro for Macintosh 6.0 or later.

e For Dial Direct connections, the remote computer must have a 56 Kbps
modem.

Older versions of Timbuktu Pro are not officially supported with Timbuktu Pro ver-
sion 8.



CHAPTER 2: INSTALLING TIMBUKTU PRO FOR
WINDOWS

This chapter will guide you as you install or un-install Timbuktu Pro on a local
computer.

To use the Network Installer or install Timbuktu Pro with Active Directory Group
Policies, see the documentation on the Timbuktu Pro Enterprise Resource Center.
The “Using Timbuktu Pro with Active Directory” document is also available on
your Timbuktu Pro CD.

BEFORE INSTALLING TIMBUKTU PRO FOR WINDOWS

Before you install Timbuktu Pro, please prepare your computer for the
installation.

You must be logged on to the local computer with Administrator or Domain Ad-
ministrator privileges to install Timbuktu Pro.

To PREPARE YOUR COMPUTER FOR TIMBUKTU PRO INSTALLATION

1. Make sure that TCP/IP software is installed and running on your computer, or
that you have a modem set up and functioning correctly.

2. Uninstall any other remote control software and restart your computer.

3. Disable or shut down any antivirus software installed on your computer.
Active antivirus programs may cause problems during the installation
process.

4. Install Timbuktu Pro.
It is extremely important to uninstall any other remote control software and re-
start your computer before you install Timbuktu Pro. If you install Timbuktu Pro

over other remote control software, or if you do not reboot after uninstalling other
software, Timbuktu Pro may not be completely installed.

[17



Installing Timbuktu Pro for Windows /18

INSTALLING TIMBUKTU PRO FOR WINDOWS

You will install Timbuktu Pro from the CD-ROM supplied in your Timbuktu Pro
package or from the Thz2ProWin.exe self-extracting archive file you downloaded
from Netopia’s Web site.

To INSTALL TIMBUKTU PRO

1. Uninstall any other remote control software, restart your computer, and close
all open applications, including antivirus software.

2. Ifyou have a Timbuktu Pro CD, insert it into your CD-ROM drive and open the
CD folder.

If you downloaded the Tb2ProWin.exe file, double-click it. You can specify the
folder where the Timbuktu Pro installation files will be extracted.

3. Double-click the TimbuktuPro.msi file to run the Timbuktu Pro MSI Installer.
The Timbuktu Pro Setup Wizard opens.

ii& Timbuktu Pro - Setup Wizard

Welcome to the Setup Wizard for Timbuktu
timbuktu pro” Pro

The Setup Wizard will install Timbuktu Pro release 8.0 on
your computer. To continue, click Next.

WARNING: This program is protected by copyright law.

| Next > | [ Cancel

4. Click Next. The Licence Agreement panel appears.
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In the License Agreement panel, select the / Accept the Terms in the License
Agreement option. Then click Next. The Destination Folder panel appears.

In the Destination Folder panel, confirm the Timbuktu Pro installation folder.

By default, Timbuktu Pro is installed in the Program Files » Timbuktu Pro
directory on the same drive where Windows is installed. To change the folder,
click Change. Otherwise, click Next.

The Ready to Install the Program panel appears.
In the Ready to Install the Program panel, click Install.

When Timbuktu Pro installation is complete, you will be notified. Click Finish
to close the Timbuktu Pro Installer.

If desired, restart your computer. You can run Timbuktu Pro immediately, but
restarting your computer will improve Timbuktu Pro’s performance.

REMOVING TIMBUKTU PRO FROM YOUR COMPUTER

Should you wish to remove Timbuktu Pro from your computer, it is important to
follow the correct uninstallation procedure.

To REMOVE TIMBUKTU PRO FROM YOUR COMPUTER

1.

Shut down Timbuktu Pro completely. (Click the File menu and choose Exit and
Shut Down Timbuktu Pro.)

From the Windows Start menu, choose Settings » Control Panel » Add or
Remove Programs.

In the list of programs, select Timbuktu Pro and click Remove.
The Add or Remove Programs dialog box appears.

Note: If you uninstall Timbuktu Pro, all files and folders in the Timbuktu Pro
installation folder will be deleted even if they are not part of Timbuktu Pro.
Make sure the folder contains no files that you wish to save.

Click Yes to confirm your intention to remove Timbuktu Pro. All the contents of
the Timbuktu Pro installation folder and its subdirectories are deleted.

When Timbuktu Pro has been uninstalled, a dialog box allows you to choose
to restart your computer immediately or later. You must restart your computer
to complete the uninstall process.



CHAPTER 3: SETTING UP TIMBUKTU PRO

Once you have installed Timbuktu Pro, you can review and change your configura-
tion settings. This chapter describes how to start and exit Timbuktu Pro and how
to set Timbuktu Pro configuration preferences.

TIMBUKTU PRO STARTUP OPTIONS

e
Q')a 5:25 PM

By default, Timbuktu Pro will start automatically when you start Windows. Its icon
is placed in the system tray on the taskbar. To open the main Timbuktu Pro win-
dow, double-click the Timbuktu Pro icon. Or right-click the icon to display the
shortcut menu, and choose Open.

Note: If you are running Windows XP, the full Timbuktu Pro application will not
start automatically. The MiniTB2 application is launched instead. MiniTB2 will
accept incoming Timbuktu Pro connections, but to establish outgoing connec-
tions, you must open the main Timbuktu Pro window by starting the full Timbuktu
Pro application. See the following section, “Starting Timbuktu Pro Manually.”

STARTING TIMBUKTU PRO MANUALLY

If Timbuktu Pro is not launched automatically, or if you shut it down, you can man-
ually start Timbuktu Pro at any time. From the Windows Start menu, choose Pro-
grams » Timbuktu Pro » Timbuktu Pro. The main Timbuktu Pro window opens.

You can configure Timbuktu Pro startup preferences using the General tab in the
Preferences dialog box (see page 22).

|20
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EXITING AND SHUTTING DOWN TIMBUKTU PRO

When you close Timbuktu Pro, you may simply exit the program, or exit and shut it
down. When you exit Timbuktu Pro without shutting it down, Timbuktu Pro contin-
ues to run in the background. Exiting without shutting down gives remote users
the ability to connect to your computer even though you aren’t making any outgo-
ing connections.

When you exit and shut down Timbuktu Pro, Timbuktu Pro no longer runs in the
background and users can no longer connect to your computer with Timbuktu Pro.

The Timbuktu Pro File menu thus has two exit options: Exit and Exit and Shut
Down Timbuktu Pro. These are explained below.

Edit View Setup Services Connections

Open Address Book...
Close Address Book

Properties... Alt+Enter
Delete Del

Exit and Shut Down Timbuktu Pro  Alt+Ctrl+F4
Exit Alt+F4

EXIT TIMBUKTU PRO OPTION

To exit without shutting down Timbuktu Pro, click the File menu and choose Exit.
Or click the Close box in the upper-right corner of the main Timbuktu Pro window.
Exiting Timbuktu Pro closes the main Timbuktu Pro window. The Timbuktu Pro
icon appears in the system tray on the Windows taskbar to remind you that Tim-
buktu Pro can still accept incoming connections. Double-click the taskbar icon to
reopen the main Timbuktu Pro window.

EXIT AND SHUT DOWN TIMBUKTU PRO OPTION

To shut Timbuktu Pro down completely, click the File menu and choose Exit and
Shut Down Timbuktu Pro. If any connections are active, they will be shut down.
Remote users will not be able to initiate new connections with your computer.

You can also shut down Timbuktu Pro by right-clicking the Timbuktu Pro icon in
the system tray on the taskbar. From the shortcut menu, choose Exit and Shut
Down Timbuktu Pro.
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CUSTOMIZING YOUR TIMBUKTU PRO PREFERENCES

The Preferences dialog box lets you specify certain configuration options for Tim-
buktu Pro. To open the Preferences dialog box, click the Setup menu and choose
Preferences. The six tabs in the Preferences dialog box are as follows:

General—Timbuktu Pro general and startup preferences. See page 22.
Observe/Control Host—Screen-sharing window preferences for when your
computer acts as the Host computer. See page 24.

Observe/Control Guest—Screen-sharing window preferences for when your
computer acts as the Guest computer. See page 29.

Send—Send service preferences. See page 33.

Notify—Notify service preferences. See page 35.

Master Password—An optional password restricting access to Timbuktu Pro’s
Preferences, Security, and LDAP Options dialog boxes. See page 36.

Dial Direct—Dial Direct preferences. See page 38.

Logging—Logging preferences. See page 39.

Note: LDAP preferences are set in the LDAP Options dialog box. See “Setting LDAP
Options” on page 41.

The following sections describe each of these tabs.

GENERAL PREFERENCES

The General tab lets you specify whether Timbuktu Pro will start when you start
Windows. You can also enter information for use by the Internet Locator Server.

TO CHANGE YOUR GENERAL PREFERENCES

1.
2.

From the Setup menu, choose Preferences.
In the Preferences dialog box, click the General tab.
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Send ] Notify ] Master Password ] Dial Direct ] Logging ]
General l Observe/Control Host ] Observe/Control Guest ]

Computer Name| Flyer

[v' start Timbuktu Pro as a service

Internet Locator

[+ Internet Locator enabled

Email Address | milehigh@tb2.com

MOTE: In order to be registered in the Internet Locator, you
must enter a valid email address. If you leave the email
address blank, you can still find other Timbulktu users via their
email address.

OK | Cancel Apply Help

3. Specify the Timbuktu Pro Computer Name. The name of your computer identi-
fies your computer to other Timbuktu Pro computers. It does not need to be
the same as your Windows networking computer name.

4. Select Start Timbuktu Pro as a Service if you want the Timbuktu Pro applica-
tion to be started as a service. For more information, see the following sec-
tion, “Launching Timbuktu Pro as a Service.”

By default, Timbuktu Pro is started as a service, which makes it available at
the network logon prompt.

5. Select Internet Locator Enabled and enter your email address if you want to
use the Internet Locator service on your computer. For information about the
Internet Locator server, see “The Internet Locator” on page 24.

6. Click OKto save your changes and close the Preferences dialog box.

LAUNCHING TIMBUKTU PRO AS A SERVICE

By default, the Timbuktu Pro application is launched as a service. It is started au-
tomatically as soon as Windows has loaded on your computer, and before Win-
dows requires you to log in. This lets you control your computer remotely and enter
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your Windows user name and password, just as if you were sitting at the com-
puter, or use services such as Exchange without logging in to Windows at all.

If you prevent Timbuktu Pro from starting automatically, you must start it manually.
See “Starting Timbuktu Pro Manually” on page 20. Note that if Timbuktu Pro does
not start automatically, you will not be able to control your computer remotely af-
ter a restart.

THE INTERNET LOCATOR

Netopia’s Internet Locator server allows you to connect to other Timbuktu Pro
computers using an email address instead of an IP address. This is particularly
helpful when a remote computer is connected to an Internet Service Provider (ISP)
that assigns dynamic IP addresses. You can enter the remote user’s email ad-
dress on the TCP/IP tab in the main Timbuktu Pro window and then select a ser-
vice. The Internet Locator server translates the email address to the correct IP
address and makes the connection using the service you selected.

Netopia maintains an Internet Locator server for public use. (Its DNS name is
findme.netopia.com.) When the Internet Locator service is enabled on your com-
puter and you launch Timbuktu Pro while connected to the Internet, your email
address and the associated IP address are automatically sent to the server. Other
Timbuktu Pro users can then connect to you by entering your email address on
the TCP/IP tab.

OBSERVE/CONTROL HOST PREFERENCES

Timbuktu Pro Control and Observe sessions take place in a screen-sharing
window, which displays the remote computer’s desktop on your screen. The
Observe/Control Host tab in the Preferences dialog box lets you specify options
that may improve screen-sharing performance and security when remote users
use the Control or Observe service with your computer.

Timbuktu Pro also supports secure screen blanking. Secure screen blanking is a
Timbuktu Pro security feature that prevents unauthorized viewing of your com-
puter’s screen while it is being controlled by a remote user. For more information,
see “Secure Screen Blanking” on page 28.
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To CHANGE YOUR OBSERVE/CONTROL HOST PREFERENCES

1. From the Setup menu, choose Preferences.
2. Inthe Preferences dialog box, click the Observe/Control Host tab.

Preferences
Send l Motify ] Master Password ] Dial Direct ] Logging ]
General Observe/Control Host l Observe/Control Guest ]

When users Observe/Control my computer:

Security
[ Blank my screen when users control my computer
[ Lock my computer when users end control sessions

[v" Allow controlling users to request screen blanking

Capture Technique Presentation

[v' Use accelerated capture [v Disable desktop wallpaper
[ Use capture frame [v Disable Active Desktop

[v Use DirectDraw [v Disable animations

[v' Use hint provider [v" Disable full window drag

[v Disable screen saver

[v "Kill" screen saver

Filter: |None hd

oK | Cancel Help

3. Inthe Security area

e Select Blank My Screen when Users Control My Computer to activate
secure screen blanking automatically when a remote user observes or
controls you computer. Secure screen blanking is a Timbuktu Pro security
feature that prevents unauthorized viewing of a computer’s screen while
itis being controlled by a remote user. See “Secure Screen Blanking” on
page 28.

When this option is selected, your screen will blank even if you are work-
ing at your computer. You may wish to select this option only if you are
the only person who uses Timbuktu Pro to access your computer
remotely.
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When this option is not selected, you screen will not blank automatically.
However, remote users can still choose to blank your screen if you select
the Allow Controlling Users to Request Screen Blanking option.

Select Lock My Computer When Users End Control Sessions to lock your
computer when an incoming Control session is complete.

For example, if the Help desk is installing new software or doing exten-
sive configuration of your system, you may need to leave your computer
before the installation is complete. When the remote user finishes con-
trolling your computer and disconnects, your computer is locked auto-
matically and remains secure until you return (as if you had pressed
CTRL+ALT+DEL and chosen Lock Workstation).

Select or clear Allow Controlling Users to Request Screen Blanking to
specify whether remote users can force your screen to blank when they
control your computer.

When this option is selected, a remote user can force your screen to
blank even if you are working at your computer. You may wish to select
this option only if you are the only person who uses Timbuktu Pro to ac-
cess your computer remotely.

When this option is not selected, remote users cannot choose whether to
blank your screen. However, your screen will still block automatically if
you selected the Blank My Screen when Users Control My Computer
option.

Note: These options are not available when you select the Use Capture Frame
option in the Capture Technique area.

In the Capture Technique area

Select Use Accelerated Capture to use the video-driver-based remote
control component, which increases Timbuktu Pro’s screen-sharing per-
formance. Clear this check box to use the Universal Remote Control
Adapter, which makes Timbuktu Pro more compatible with different
video cards and video settings.

The Universal Remote Control Adapter also supports systems with multi-
ple monitors. If you have a multiple-monitor setup, disable the Use Accel-
erated Capture option.

Select the Use Capture Frame option to restrict the view of your desktop
when a remote computer establishes a Control or Observe connection to
your computer. During the screen-sharing session, only the portion of
your desktop that appears in the Capture Frame is displayed in the
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screen-sharing window on the remote computer. For details, see the fol-
lowing section, “Enabling the Remote Control Capture Frame.”

e Select orclear Use DirectDraw to enable or disable the use of DirectDraw
(which allows Timbuktu Pro to send screen information directly to the
video adapter). In most cases, you will not need to disable this option.

e Select orclear Use Hint Provider to enable or disable the use of Hint Pro-
vider (which allows Timbuktu Pro to access application messages). In
most cases, you will not need to disable this option.

In the Presentation area, select or clear the appropriate check boxes to set
options as desired.

The Presentation settings allow you to control the appearance and behavior
of your desktop while remote users are observing or controlling your com-
puter. Most of the Presentation options, when selected, will increase the
screen-sharing performance of Timbuktu Pro during remote-control sessions.

e Disable Desktop Wallpaper removes the Windows wallpaper from your
desktop while a remote user is controlling or observing your computer.
The wallpaper is restored when the remote control session ends.

e Disable Active Desktop disables Active Desktop on your computer while a
remote user is controlling or observing your computer. Active Desktop is
restored when the remote control session ends.

e Disable Animations disables desktop animations on your computer while
a remote user is controlling or observing your computer. Desktop anima-
tions are restored when the remote control session ends.

e Disable Full Window Drag disables full window drag (in which the win-
dow’s contents are displayed while it is dragged) on your computer while
a remote useris controlling or observing your computer. Full window drag
is restored when the remote control session ends.

e Disable Screen Saver prevents the screen saver from running on your
computer while a remote user is controlling or observing your computer.

e “Kill” Screen Saver deactivates the screen saver on your computer at the
start of an incoming remote control session.

In the Presentation area, select an option from the Filter drop-down list. The
Filter option forces a color-depth reduction before screen-sharing data is sent
from your computer to the guest computer. (The Loss-Less option disables
color-depth reduction.)

Click OK to save your changes and close the Preferences dialog box.
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ENABLING THE REMOTE CONTROL CAPTURE FRAME

When you enable the Use Capture Frame option on the Observe/Control tab in the
Preferences dialog box, the Capture Frame will open on your desktop when a re-
mote computer establishes a Control or Observe connection to your computer.

The Capture Frame restricts the remote user’s view of your desktop. During the
screen-sharing session, only the portion of your desktop that appears in the Cap-
ture Frame is displayed in the screen-sharing window on the remote computer. In
addition, the screen-sharing session will not begin until you click the Play button
in the upper-left corner of the Capture Frame.

Note: Do not enable the Use Capture Frame option if anyone will need to use the
Control or Observe service to access your computer when you are not present.
Because you must click the Play button to allow the screen-sharing session to
proceed, you must be physically present at the host computer.

For additional information about using the Capture Frame, see “Using the Capture
Frame” on page 70.

SECURE SCREEN BLANKING

Secure screen blanking is a Timbuktu Pro security feature that prevents unautho-
rized access to your computer while it is being controlled by a remote user. When
secure screen blanking is active, no one will be able to see what is happening on
the computer’s desktop. (They may be able to see the cursor move and hear any
audio the computer generates.)

Secure screen blanking works differently in different situations: whether or not
you are logged in to your computer, and—if you’re logged in—whether or not your
computer is locked before the remote user takes control.

You should always protect the security of your computer by using a password-pro-
tected screen saver. When you are away from your computer, the locking mecha-
nism will help to ensure your security.

WHEN YOU’RE WORKING AT YOUR COMPUTER

If you are working at your computer and a remote user controls it (for example, the
Help Desk takes control to troubleshoot a problem you’re having), the screen will
not blank. You will be able to watch the remote user’s actions and, if necessary,
disconnect the user from your computer.
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Note: Your screen will blank, even if you are using your computer, if you selected
the Allow Controlling Users to Request Screen Blanking option and the remote
user requests the screen to blank.

WHEN YOUR SCREEN IS LOCKED

If your computeris locked and a remote user controls it, the screen will blank. You
will not be able to activate your monitor until the remote user disconnects. When
the remote user ends the control session, the Workstation Locked dialog box will
reappear.

WHEN YOU HAVEN’T LOGGED IN

If you have not logged in to your computer and a remote user controls it, the
screen will blank. You will not be able to activate your monitor until the remote
user disconnects. When the remote user ends the control session, the Logon In-
formation dialog box will reappear.

OBSERVE/CONTROL GUEST PREFERENCES

Timbuktu Pro Control and Observe sessions take place in a screen-sharing
window, which displays the remote computer’s desktop on your screen. The
Observe/Control Guest tab in the Preferences dialog box lets you control the ap-
pearance and behavior of the screen-sharing window. You may specify options
that may improve screen-sharing performance and security during screen-sharing
sessions.

Timbuktu Pro also supports secure screen blanking. Secure screen blanking is a
Timbuktu Pro security feature that prevents unauthorized viewing of your com-
puter’s screen while it is being controlled by a remote user. For more information,
see “Secure Screen Blanking” on page 28.

To CHANGE YOUR OBSERVE/CONTROL GUEST PREFERENCES

1. From the Setup menu, choose Preferences.
2. Inthe Preferences dialog box, click the Observe/Control Guest tab.
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Preferences Rl
Send ] Notify ] Master Password ] Dial Direct ] Logging ]
General ] Observe/Control Host Observe/Control Guest
Window

[+ Automatically scroll [ Always on top [ Shrink to fit

[+ Show scrollbars [ Start maximized

When controlling, request the other computer to:

Security: Presentation:
[ Blank the screen |v Disable desktop wallpaper
Capture Technique: |v Disable Active Desktop

|v Disable animations

[v' Use accelerated capture
[v Disable full window drag

[v Use DirectDraw
[v' Use hint provider

v "Kill" screen saver
Keyboard handling:

[v' Use logical keyboard Filter: |None :Iv

[v' Synchronize lock states

|v Disable screen saver

[ Map control key to command key

oK | Cancel Help

In the Window area

Select Automatically Scroll to scroll the screen-sharing window automati-
cally when your mouse pointer approaches the edge of the window or
when the pointer on the remote desktop moves out of view.

If this option is not selected, automatic scrolling will not occur. You can
scroll the window manually by clicking on the scroll bars at the edge of
the window.

Note: Because there are no scroll bars when a screen-sharing window is
maximized, a maximized window always scrolls automatically.

Select Show Scrollbars to display scroll bars in the screen sharing win-
dow. (When the screen-sharing window is maximized, scroll bars will not
appear, even when this option is selected.)

Select Always On Top to force the screen sharing window to remain on
top of all other application windows.
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e Select Start Maximized to start screen-sharing sessions with the screen-
sharing window maximized.

e Select Shrink to Fit to shrink (or enlarge) the image of the remote desktop
to fit entirely within the screen-sharing window. If you reduce or enlarge
the window, the remote desktop will resize automatically to fit. However,
the remote desktop will never be enlarged beyond its actual size.

In the Keyboard area

e Select Map Control Key to Command Key to specify that your CTRL key
acts as the COMMAND key when you control a Macintosh computer.

e Select Use Logical Keyboard to use logical keyboard mapping if the host
and guest computers use different keyboard types. For example, if the
host computer uses a Qwerty keyboard and the guest computer uses a
Dvorak keyboard, pressing the Y key on the guest computer will have the
same effect as pressing the Y key on the host computer.

Physical mapping, which is used if this option is not selected, maps keys
based on their physical location on the keyboard. For example, if the
host computer uses a Qwerty keyboard and the guest computer uses a
Dvorak keyboard, pressing the Y key on the guest computer will be trans-
lated as a T on the host computer.

e Select Synchronize Lock States to match the CAPS LOCK, NUM LOCK, and
SCROLL LOCK settings on the host computer to the settings on the guest
computer. This matching occurs as soon as you press a key while the
screen-sharing window is in focus.

If this option is not selected, the host computer’s CAPS LOCK, NUM LOCK,
and SCROLL LOCK settings will not change.

In the Security area, select Blank the Screen to activate secure screen blank-
ing when you Observe or Control another computer. Secure screen blanking
is a Timbuktu Pro security feature that prevents unauthorized viewing of a
computer’s screen while it is being controlled by a remote user. See “Secure
Screen Blanking” on page 28.

Note: Screen blanking will occur only if the host computer allows it. If the
Blank My Screen when Users Control My Computer setting is enabled, blank-
ing will occur whether or not you request it. If the Blank My Screen setting is
not enabled, the screen will blank only if the user of the host computer has
enabled the Allow Controlling Users to Request Screen Blanking setting.
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In the Capture Technique area

e Select UseAccelerated Capture to use the video-driver-based remote
control component, which increases Timbuktu Pro’s screen-sharing per-
formance. Clear this check box to use the Universal Remote Control
Adapter, which makes Timbuktu Pro more compatible with different
video cards and video settings.

The Universal Remote Control Adapter also supports systems with multi-
ple monitors. If you have a multiple-monitor setup, disable the Use Accel-
erated Capture option.

e Select or clear Use DirectDraw to enable or disable the use of DirectDraw
(which allows Timbuktu Pro to send screen information directly to the
video adapter). In most cases, you will not need to disable this option.

e Select or clear Use Hint Provider to enable or disable the use of Hint Pro-
vider (which allows Timbuktu Pro to access application messages). In
most cases, you will not need to disable this option.

Note: If these settings are not enabled on the host computer, but enabled on
the guest computer, the guest settings will be used during the screen-sharing
session. However, if these settings are enabled on the host computer, the
guest computer cannot disable them.

In the Presentation area, select or clear the appropriate check boxes to set
options as desired.

The Presentation settings allow you to control the appearance and behavior

of the remote desktop while you observe or control a remote computer. Most
of the Presentation options, when selected, will increase the screen-sharing

performance of Timbuktu Pro during remote-control sessions.

e Disable Desktop Wallpaper removes the Windows wallpaper from the
host computer’s desktop when you are controlling or observing the com-
puter.

e Disable Active Desktop disables Active Desktop on the host computer
when you are controlling or observing the computer.

e Disable Animations disables desktop animations on the host computer
when you are controlling or observing the computer.

e Disable Full Window Drag disables full window drag (in which the win-
dow’s contents are displayed while it is dragged) on the host computer
when you are controlling or observing the computer.
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e Disable Screen Saver prevents the screen saver from running on the host
computer while you are controlling or observing the computer.

e “Kill” Screen Saver deactivates the screen saver on the host computer at
the start of the remote control session.

Note: If these settings are not enabled on the host computer, but enabled on
the guest computer, the guest settings will be used during the screen-sharing
session. However, if these settings are enabled on the host computer, the
guest computer cannot disable them.

8. Inthe Presentation area, select an option from the Filter drop-down list. The
Filter option forces a color-depth reduction before screen-sharing data is sent
from the host computer to your computer.

During the remote-control session, Timbuktu Pro checks the Filter setting on
both the host and guest computer. The more restrictive (faster) setting is
used.

9. Click OKto save your changes and close the Preferences dialog box.

SEND PREFERENCES

The Send service lets you send messages called FlashNotes to other Timbuktu Pro
computers. You can customize Timbuktu Pro to notify you of an incoming
FlashNote by displaying the FlashNote in a full-sized window or by displaying the
FlashNote as a minimized icon on the taskbar. In addition, you can designate how
much of your disk space should be protected from temporary storage of
FlashNotes and their enclosures.

TO CHANGE YOUR SEND PREFERENCES

1. From the Setup menu, choose Preferences.
2. Inthe Preferences dialog box, click the Send tab.
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General ] Observe/Control Host ] Observe/Control Guest ]
Send l Motify ] Master Password ] Dial Direct ] Logging ]

When a note arrives on my computer
i@ Show in a full-sized window

(~ Show as a minimized icon

Disk Usage
Megabytes of disk space protected from use by FlashMotes: 10

Save files inside this folder:
CAPROGRAM FILES\TIMBUKTU PRO

Browse...
0K | Cancel ‘ Apply ‘ Help ‘

In the When a Note Arrives on My Computer area, select Show in a Full-Sized
Window to see newly received FlashNotes and attached enclosures
immediately. Select Show as a Minimized Icon to display the FlashNote as an
icon in the taskbar. The icon indicates that a message has arrived.

In the Disk Usage area

e To limit the amount of disk space used by files sent by the Send service,
enter the desired number of megabytes in the Megabytes of Disk Space
Protected from Use by FlashNotes field. This prevents users from entirely
filling up your disk with FlashNotes and enclosures.

e Files transferred using the Send function are stored in the files received
folder. Specify the location of the files received folder on your computer
in the Save Files Inside this Folder field.

If someone attempts to send files or folders that would require more disk
space on your computer than is available, Timbuktu Pro notifies them that
there isn’t enough disk space to carry out the file transfer.

This option does not restrict file transfer using the Exchange service.
Click OK to save your changes and close the Preferences dialog box.
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NOTIFY PREFERENCES

The Notify service lets remote users request notification when your computer be-
comes active. You can specify that Timbuktu Pro prompt you before responding to
a notification request, or you can configure Timbuktu Pro to respond to notifica-
tion requests automatically, based on your mouse and keyboard activity.

To CHANGE YOUR NOTIFY PREFERENCES

1. From the Setup menu, choose Preferences.
2. Inthe Preferences dialog box, click the Notify tab.

General ] Observe/Control Host ] Observe/Control Guest ]
Send Notify l Master Password ] Dial Direct ] Logging ]

If someone asks to be notified when | become active

i® Promptme for an answer

("~ Answer automatically (based on mouse and keyboard activity)

When someone asks to be notified, tell them...

[ When | lastused my computer.

[v Message: Daily conference call 9—1DAM.|

0K | Cancel ‘ Apply Help

3. Inthe/f Someone Asks to be Notified when | Become Active area

e Select Prompt Me for an Answer if you do not want Timbuktu Pro to auto-
matically notify users that you have become active. Timbuktu will indi-
cate which user has requested notification, and you can then choose to
notify or not to notify the user that you are available at your computer.

e Select Answer Automatically if it is OK for all users to whom you’ve
granted the Notify service to know when your computer has become
active (based on keyboard and mouse activity). Whenever a remote user
asks for notification, Timbuktu Pro will notify that user that you have
become active without telling you who is asking for notification.
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4. Inthe When Someone Asks to be Notified, Tell Them area

e Select When [ Last Used my Computer to display this information to the
remote user. The user will be told the date and time when you last used
your mouse or keyboard.

Note: If you selected Prompt Me for an Answer in step 3, and you choose
not to notify a remote user that your computer has become active, the
date and time of your last activity will not be updated on the remote com-
puter when you become active.

e Select Message and enter a message to be displayed when the remote
user asks for notification.

5. Click OK to save the changes and close the Preferences dialog box.

SETTING UP YOUR MASTER PASSWORD

Use a master password to protect access to those parts of Timbuktu Pro that allow
you to change Timbuktu Pro’s configuration—the Security, Preferences, and LDAP
Options dialog boxes. After you’ve created a master password, Timbuktu Pro will
ask you to type it whenever you attempt to open these dialog boxes.

If you protect your Timbuktu Pro settings with a master password, be sure you
choose a password you will remember. If you forget your master password, you
will need to uninstall and reinstall Timbuktu Pro.

To SET OR CHANGE YOUR MASTER PASSWORD

1. From the Setup menu, choose Preferences.
2. Ifyou have an existing master password, enter it when prompted.
3. Inthe Preferences dialog box, click the Master Password tab.
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General ] Observe/Control Host ] Observe/Control Guest ]
Send ] Motify Master Password l Dial Direct ] Logging ]

Setthe Master Password

The Password and Confirm boxes must be identical or blank.

Password: |

Confirm: |m1

Master Password protects access to Preferences and Security windows

0K | Cancel Apply Help

Type the new password in the Password box. The characters you enter are dis-
played as asterisks. Passwords are case-sensitive.

Re-type the master password in the Confirm box.
Click OK to save the changes and close the Preferences dialog box.

Timbuktu Pro will not let you close the Preferences dialog box unless the
Password and Confirm fields match exactly.

REMOVING YOUR MASTER PASSWORD

If you wish to unprotect your Security, Preferences, and LDAP settings, you may re-
move your master password.

To REMOVE YOUR MASTER PASSWORD

=

Goe W

From the Setup menu, choose Preferences.

When prompted, enter your existing master password.

In the Preferences dialog box, click the Master Password tab.

Delete the text from both the Password and Confirm boxes.

Click OK to save your changes and close the Preferences dialog box.



Customizing Your Timbuktu Pro Preferences /38

DIAL DIRECT PREFERENCES

The Dial Direct tab in the Preferences dialog box lets you determine how incoming
calls are answered by your system. It also allows you to specify the modem that
will be used and how idle connections are handled.

By default, Timbuktu Pro will not answer incoming Dial Direct calls. If you wish to
accept Dial Direct connections, you must change your Dial Direct options on the
Dial Direct tab in the Preferences dialog box.

To CHANGE YOUR DIAL DIRECT OPTIONS

1. From the Setup menu, choose Preferences.
2. Inthe Preferences dialog box, click the Dial Direct tab.

General ] Observe/Control Host ] Observe/Control Guest ]
Send ] Notify ] Master Password Dial Direct l Logging ]

Device: |Conexant V.9 Modem ﬂ

Onincoming calls:

i~ Do notanswer
(@ Answer after |1 rings

[ Disconnectcall ifidle for minutes

0K | Cancel ‘ Apply Help

3. Select the modem you wish to use from the Device drop-down list. Timbuktu
Pro will list the available modems as determined by your operating system. If
you need to set or change the properties of the selected modem, click the
Properties button. (See your modem documentation for a discussion of the
information required in the Modem Properties dialog box.)

4. Under On Incoming Calls, choose an option to answer calls to your computer.

e Choose Do Not Answer to ignore all incoming calls. This is the default
option.

e Choose Answer After n Rings to answer calls automatically after the num-
ber of rings specified in the text box.



Customizing Your Timbuktu Pro Preferences /39

5. If you wish to automatically close an idle connection after a specific amount
of time, select the Disconnect Call checkbox and specify the number of min-
utes of inactivity after which the connection will automatically be terminated.

You may wish to automatically disconnect idle callers to allow another user
access when the current user is idle for long periods or forgets to disconnect.

6. Click OK to save your changes and close the Preferences dialog box.

DIALING PROPERTIES

To make outgoing connections, you may also need to set options—such as a dial-
ing prefix—in the Dialing Properties dialog box. You can open the Dialing Proper-
ties dialog box by clicking the Dialing Properties button on the Dial Direct tab in
the main Timbuktu Pro window. See your Windows or modem documentation for
more information about the Dialing Properties dialog box.

LOGGING PREFERENCES
Timbuktu Pro now supports multiple options for both local and centralized event
logging.

Among other options, you may specify the maximum size for your log files. When
the maximum size for the active log file is reached, its contents are copied to a
backup file and removed from the primary file. This allows the primary file to re-
main small, which may improve performance if you use centralized logging.

Note: Depending on your Timbuktu Pro installation, the Logging tab may not
appear.

For details about the various types of logging, see “Timbuktu Pro Logging” on
page 95.
To CHANGE YOUR TIMBUKTU PRO LOGGING OPTIONS

1. From the Setup menu, choose Preferences.
2. Inthe Preferences dialog box, click the Logging tab.
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General ] Observe/Control Host ] Observe/Control Guest ]
Send ] Notify ] Master Password ] Dial Direct Logging
[+ Use Timbuktu Log Server: | Use NT Event Log Server:

[v' Enable event log file:

Maximum size: | 16384 KB Browse...

[v' Log configuration changes to these settings

|
=

AdmitTempGuest EnableBlankWorkstation TimbuktuMame ~
NolLaunchAtBoot LocatorFeatureOn EmailAddress DropFolder
DropFolderProtection ReportLastActive ReportMessage v

Activity log maximum 32 KB

MOTE: A maximum size of 0 for any log file means an unbounded file.
NOTE: Most changes take effect after restarting Timbuktu.

0K | Cancel ‘ Apply Help

To copy information from your Timbuktu Pro activity log or Event Log file to
another Timbuktu Pro computer, select the Use Timbuktu Log Server check-
box. Then enter the remote computer’'s Windows name in the text box.

The “server” does not need to be a Windows server. However, the computer
you specify must be running Timbuktu Pro, and it must be visible to your com-
puter. Logging information from your computer will be written to the remote
activity log automatically, and to the remote Event Log file if one is configured
for the remote computer.

To copy information about Timbuktu Pro events from your Windows Applica-
tion Event Log to the Application Event Log on another Timbuktu Pro com-
puter, select the Use NT Event Log Server checkbox.

The Enter NT Event Log Server dialog box opens. Enter the remote computer’s
Windows name and your administrator-level user name and password.
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Note: To enable remote Application Event logging, you must have

e Administrator privileges on the remote computer
e Interactive login privileges on the Windows domain
® Access to the Windows Application Event Log on the remote computer

5. To create an Event Log file, a text document which records the same informa-
tion that Timbuktu Pro records in the Windows Application Event Log, select
the Enable Event Log File checkbox.

Then specify the log file location and enter a maximum size for the log file in
the Maximum Size text box.

When the maximum size for the active log file is reached, its contents are
copied to a backup file and removed from the primary file. This allows the pri-
mary file to remain small.

6. Select the Log Configuration Changes to These Settings checkbox to specify
that configuration changes should appear in the log. Changes to the settings
listed in the Value Names text box will be logged.

7. Enterthe maximum size for the activity log in the Activity Log Maximum text
box.

When the maximum size for the active log file is reached, its contents are
copied to a backup file and removed from the primary file. This allows the pri-
mary file to remain small.

8. Click OKto save your changes and close the Preferences dialog box.
Shut down and restart Timbuktu Pro to enable the new settings.

SETTING LDAP OPTIONS

To use the LDAP server’s search functionality, you will need to set your prefer-
ences and user information in the LDAP Options dialog box. From the Setup
menu, choose LDAP.
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LDAP Options X
General lAdvanced ] User's Profile ]

[v" Enable LDAP directory feature

Server information

Server name: |daptestnetopia.com

[ Active Directory Server

-

0K | Cancel Apply

The three tabs in the LDAP Options dialog box—General, Advanced, and User’s
Profile—allow you to enable the LDAP functionality, determine port usage, and
provide your own user information to the search tools on the server.

GENERAL TAB

Click the General tab to enable the LDAP Directory feature and specify a server.
Netopia’s public LDAP server is located at ldaptest.netopia.com.

ADVANCED TAB

Click the Advanced tab to change the default LDAP contact port number and LDAP
search base. You should not need to change the information on this tab unless
you are a system administrator. The default port number is 389, and the default
search base is o=timbuktu. This port and search information is required for suc-
cessful access to Netopia’s public LDAP server.
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USER’S PROFILE TAB

Click the User’s Profile tab to provide the user information that you want to regis-
ter with the LDAP server. The information you provide will be saved to the server,
and it will be queried when another user searches the server.

To CREATE YOUR LDAP USER PROFILE

1. From the Setup menu, choose LDAP.
2. Inthe LDAP Options dialog box, click the User’s Profile tab.

LDAP Options g|

General ] Advanced User's Profile ]

User's Name: |Aria| Scott

E-mail Address: | aria@th2.com

Location: |N0r‘th Building, 3rd Floor

Comment: Conference call daily 3PM.

OK | Cancel Apply Help

3. Enterthe appropriate information in each field. All information is optional.
However, complete and accurate information will make it easier for other
users to find your computer quickly.

4. Choose OK to save your changes and close the LDAP Options dialog box.
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CONTROLLING ACCESS TO YOUR COMPUTER

There are several ways of maintaining security and restricting access to your com-
puter by other Timbuktu Pro computers. You may use a master password to pre-
vent anyone with direct access to your computer from changing your Timbuktu Pro
preferences. (See “Setting Up Your Master Password” on page 36.) In addition, no
remote computer can connect to your computer without your prior authorization.
There are several levels of remote access: you may assign privileges to all Guest
Users, allow remote users to ask for permission to use unassigned services, and
create Registered Users and Windows NT Users with specific privileges. The setup
of various security measures is discussed in detail in “Chapter 6: Security.”

As an administrator, you may also use Active Directory Group Policies and Site
Keys to control security settings on your entire network. Full documentation for
Timbuktu Pro with Active Directory is available. See the “Using Timbuktu Pro with
Active Directory” PDF document on your Timbuktu Pro CD or on the Timbuktu Pro
Enterprise Resource Center. Site Key documentation is also available on the Tim-
buktu Pro Enterprise Resource Center.



CHAPTER 4: MAKING A TIMBUKTU PRO CONNECTION

This chapter discusses how you can use the connection tabs in the main Tim-
buktu Pro window to connect to remote computers.

THE MAIN TIMBUKTU PRO WINDOW

When you open Timbuktu Pro, you will see the following window.
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MENUS

Use Timbuktu Pro menus to make connections, customize your Timbuktu Pro,
and define users. For more information about each menu, see “Menus in Tim-
buktu Pro” in the Timbuktu Pro online Help.

SERVICE BUTTONS

You can use service buttons as shortcuts for the Send, Exchange, Observe, Con-
trol, Notify, Chat, Intercom, and Invite options in the Services menu. All the ser-
vice buttons remain dimmed until you have entered or selected an address in one
of the connection tabs. For details, see “Timbuktu Pro Service Toolbar” in the on-
line Help.

CONNECTION TABS

You can use the connection tabs to enter or select the addresses of other Tim-
buktu Pro computers you wish to connect to. To bring a tab to the front, click it.

The fact that a remote address is displayed in one of the connection tabs does not
automatically enable you to connect to that computer. Addresses remain visible
in the Address Books and Recent Connections tabs even when the computers at
those addresses are not running Timbuktu Pro or are shut down.

In addition, the user of the remote computer may not grant you permission to con-
nect using the service you have selected. To learn more about access restrictions,
see “Chapter 6: Security.”

STATUS BAR

The status bar, at the bottom of the main Timbuktu Pro window, contains two in-
formation panels. The panel on the right displays the TCP/IP address of the com-
puter. Other Timbuktu Pro users will use this address to connect to you.
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THE TiIMBUKTU PRO CONNECTION PROCESS

Before you can use any Timbuktu Pro service with a remote computer, you must
establish a connection with the computer.

As long as you have been granted access as a Guest User, Ask for Permission
User, Registered User, or Windows NT User, you can connect to any computer that
is running Timbuktu Pro over a TCP/IP network. If you have a modem, you may
also make a direct modem-to-modem connection—with no network required.

SELECTING A REMOTE COMPUTER

When selecting a remote computer, you may wish to make

e Anew TCP/IP connection to a computer you have not connected to before.
Use the TCP/IP tab (see page 48) or LDAP tab (see page 52). Or use the Tim-
buktu Pro Scanner to search for the computer you need (see page 53).

e ATCP/IP connection to a remote computer that you have connected to before.
Use the Address Books or Recent Connections tab (see page 54), or choose a
previously-used connection from the drop-down list on the TCP/IP tab.

e A Dial Direct connection. Use the Dial Direct tab (see page 57.)

CHOOSING A SERVICE

Once you have specified the remote computer you’re connecting to, you must
choose the service you wish you use.

e C(lick a service button on the Services toolbar.
e Choose a service from the Services menu.

The Timbuktu Pro services are addressed in detail in “Chapter 5: The Timbuktu
Pro Services.”
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RE-ESTABLISHING AN EARLIER CONNECTION

If you’ve previously connected to the same remote computer, your connection
properties will have been saved to the Recent Connections tab. Or you may have
created an address book entry for the computer you want. On the Address Books
or Recent Connections tab, double-click the selected address to connect using the
default service (the service used during the last connection) for that address. You
may also be able to reconnect from the TCP/IP tab by clicking the TCP/IP Address
drop-down list and selecting the remote address, or from the Dial Direct tab by
clicking the Phone Number drop-down list and selecting the phone number.

For information about saving connection properties to the address book, see “Us-
ing the Address Books” on page 55.

USING A TIMBUKTU PRO CONNECTION DOCUMENT

You may save connection properties to the desktop for quick access using a Tim-
buktu Pro Connection Document. Timbuktu Pro Connection Documents are desk-
top shortcuts that allow you to start a Timbuktu Pro connection to a specific
remote computer from a desktop icon.

Connection Documents are created by right-clicking over the desktop and choos-
ing New » Timbuktu Pro Connection Document. For more information on creating,
editing, and using Timbuktu Pro Connection Documents, see “Timbuktu Pro Con-
nection Documents” on page 59.

MAKING A NEwW CONNECTION

You can establish a Timbuktu Pro connection to a computer you haven’t used be-
fore in several ways. You may enter its IP address, Timbuktu Pro computer name,
or email address in the TCP/IP tab. You may search for remote computers meeting
specific criteria in the LDAP tab. Or you may use the Timbuktu Pro Scanner to
search your network for active Timbuktu Pro computers.

You may also establish a Dial Direct connection. See “Making a Dial Direct Con-
nection” on page 57.
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UsING THE TCP/IP TaB

The most common way to open a new Timbuktu Pro connection is to use the
TCP/IP tab in the main Timbuktu Pro window.

To MAKE A NEW CONNECTION

1. To connect to a remote computer for the first time, click the TCP/IP tab.

= Timbuktu Pro - Flyer E‘EJB|

Fle Edt View Setup Services Connections Help

Send Exchange Control Observe  Notify Chat  Intercom  Invite

[EF]jaddress & TR % LDAP Dial
Books =] 1325 Direct
TCP/IP Address: | 34.23.33.18 | HE

[v Use SSH |admin

Type in the name or address of the An IP address should be of the form:
remaote computer you wish to connact to. 163.176.1.105

NOTE: The SSH contact information has An IP DNS name should be of the form:
this syntax: name.host.com

[username] [@ssh_host] [:ssh_port] [/c] An IP WINS name is like a DNS name
but may contain spaces of the form:
The default username is your login name. Dept NT Server
The default ssh_host is the same as
entered in the Address field. Use /c to
enable data compression.

An Internet Locator name should be of
the form: name@company.com
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2. Inthe TCP/IP Address text box, enter the IP address of the remote computer.

If you don’t know the IP address, and the Internet Locator service is enabled
on the remote computer, you may enter the computer user’s email address.

(See “The Internet Locator” on page 24 for more information about the Inter-
net Locator.) You may also enter the computer’'s DNS name or WINS name if

one has been assigned.

3. Ifyou wish to use SSH to secure your connection, select the Use SSH check
box. Then enter your OS-level user name for the remote computer.
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The user name that you enter must be defined in the operating system for the
remote computer. Before the connection is completed, you will be prompted
to enter the password associated with the user name you specified.

Note: To connect securely to a Macintosh computer, you must enter your Mac
0S X user name and password for that computer. In addition, the user of the
remote Macintosh computer must create a Mac OS X Registered User account
that allows you access. For details, see your Timbuktu Pro for Macintosh doc-
umentation.

For details about SSH connections, see the following section, “Connecting
Securely with SSH.”

4. Choose any service from the Services menu or click on the service button that
you want to use.

For detailed information about each service, see “Chapter 5: The Timbuktu
Pro Services.”

5. To complete the connection to the remote computer, you may need to log on
as a Registered User or ask for permission. See “Connecting as a Registered
User or Ask for Permission User” on page 51.

CONNECTING SECURELY WITH SSH

To establish a Timbuktu Pro session with a remote computer over a secure SSH
connection, you must enter your OS-level user name for the remote computer. Be-
fore the connection is completed, you will be prompted to enter your password.

If you enter only your user name, the default SSH port is assumed and SSH au-
thentication is performed on the remote computer to which you connect. How-
ever, you may also specify the SSH port to use, the SSH address for a gateway
through which you wish to connect, or both.

Note: To connect securely to a Macintosh computer, you must enter your Mac 0S

X user name and password for that computer. In addition, the user of the remote

Macintosh computer must create a Mac OS X Registered User account that allows

you access. For details, see your Timbuktu Pro for Macintosh documentation.

Specifying the SSH Port

To specify the SSH port, enter your user name and the SSH port in the format
username:sshport

For example, enter tb2user:3423 to use the port 3423.

If you do not specify a port, the default SSH port (22) is assumed.
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Specifying the SSH Gateway

You may also establish an SSH connection through an SSH “gateway” computer.
The SSH server on the gateway computer performs the SSH authentication before
establishing the Timbuktu Pro connection to the remote computer.

For example, you may use the SSH gateway to establish a connection to a com-
puter behind a firewall by working through an SSH port in the firewall. The SSH
port connects to the SSH server behind the firewall, which can resolve the IP ad-
dress you entered for the remote computer.

To specify an SSH gateway, enter your user name and the SSH gateway address in
the format

username@sshaddress

The SSH address can be an IP number or DNS name. For example, enter
tb2user@ssh.timbuktupro.com.

If you do not specify an SSH gateway, SSH authentication is performed on the
Timbuktu Pro computer to which you connect.

Please note that, if you use an SSH gateway to secure your Timbuktu Pro connec-
tion, the connection is encrypted only between your computer and the SSH gate-
way. The connection from your computer is decrypted at the SSH gateway, and
the connection between the gateway and the host Timbuktu Pro computer is not
encrypted.

Specifying the SSH Port and the SSH Gateway

To specify both the SSH port and the SSH gateway, enter your user name and the
SSH information in the format

username@sshaddress:sshport

For example, enter tb2user@ssh.timbuktupro.com:3423.

CONNECTING AS A REGISTERED USER OR ASK FOR PERMISSION USER

If you attempt to connect to a remote computer using a Timbuktu Pro service that
is not assigned to Guest Users, the Log In dialog box will appear on your screen.

If you have a Registered User account on the remote computer, select the Log In
as Registered User radio button. Enter your log in name and password and click
OK. (You may also change your password if desired or if prompted to do so.)
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If you do not have a Registered User account, ask for permission to access the re-
mote computer. Select the Ask for Permission radio button and click OK. If the
user of the remote computer grants your request, you will be admitted.

Note: The user of the remote computer may have disabled the Ask for Permission
option. If the Ask for Permission radio button is not available, you must use other
means to contact the remote user to be granted access.

USING THE LDAP SERVER TO FIND A REMOTE COMPUTER

The LDAP tab in the main Timbuktu Pro window allows you to search for other Tim-
buktu Pro computers when you don’t know their IP addresses. Once the desired
computer is found, you may connect to it without leaving the LDAP tab.

Note: The LDAP tab appears only if Enable LDAP Directory Feature is selected in
the LDAP Options dialog box.

To FIND A REMOTE USER USING THE LDAP SEARCH FEATURE

1. Inthe main Timbuktu Pro window, click the LDAP tab.
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2. Inthe Search For box, type a search string. This can be some portion of the
remote user’s login name, computer name, email address, or any other
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information stored in their user profile. Enter * as a wildcard character when
you are not certain of the entire search string.

Click Find Now and Timbuktu Pro will search the LDAP server for users whose
profiles include your search string. Up to 500 entries will be returned, unless
your system administrator has set a different value.

To make a Timbuktu Pro connection to the desired computer, click the com-
puter's name in the list of computers and choose a service from the Timbuktu
Pro Service toolbar. Or right-click on the user’'s name and choose a service
from the shortcut menu.

SCANNING THE NETWORK FOR TIMBUKTU PRO COMPUTERS

The Timbuktu Pro Scanner helps you find and connect to remote computers, even
when you don't know their IP addresses, by browsing your local network for active
Timbuktu Pro computers. Once the desired computer is found, you may connect
to it without leaving the Timbuktu Pro Scanner.

By default, the Timbuktu Pro Scanner scans the local TCP/IP subnet. Your system
administrator can customize and extend the range of the search.

To MAKE A CONNECTION USING THE TIMBUKTU PRO SCANNER

1.
2.

From the Connections menu, choose Timbuktu Pro Scanner.

The Timbuktu Pro Scanner window opens. The search begins automatically.
The remote computers found by the Timbuktu Pro Scanner appear in the Tim-
buktu Pro Scanner window.

 Timbuktu Pro Scanner Q@S|

Timbuktu Fro has been detected on:

Camputer Mame | IP Address |
ELDENT 2401.30.25
BLzaK 240.1.30.26
L RINGER 2401.30.24
BL RN 240.1.30.23
& blue 240.1.30.21

Seatch | Sawve Exit
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3. When the scan is complete, the word Ready will appear in the status bar at
the bottom of the Timbuktu Pro Scanner window.

4. To make a Timbuktu Pro connection to a listed computer, right-click the com-
puter name. From the shortcut menu, choose the service that you wish to
use.

To complete the connection to the remote computer, you may need to log on
as a Registered User or ask for permission.

To SAVE ADDRESSES FROM THE TIMBUKTU PRO SCANNER

Saving frequently-used TCP/IP addresses in an address book allows you more
convenient access in the future. You may save the results of a Timbuktu Pro scan
in a custom address book, enabling future connections without requiring you to
run the Timbuktu Pro Scanner.

1. Inthe Timbuktu Pro Scanner window, click the Save button.
2. Specify a file name for the new address book and click Save.

3. If desired, edit the new address book to add additional addresses or remove
addresses you don’t need.

For more information about creating, editing, and using address books, see “Us-
ing the Address Books” on page 55.

RE-ESTABLISHING A PREVIOUS CONNECTION

When you connect to a remote computer, a record of the connection is saved to
the Recent Connections tab in the main Timbuktu Pro window. If you use the
TCP/IP tab or Dial Direct tab to connect, a connection record is saved to that tab
as well. Finally, you may save previous connections to an address book (on the
Address Books tab) to make future connections easier.

Note: Dial Direct connections are not recorded in the Recent Connections tab and
cannot be saved to address books. Use the Phone Number drop-down list on the
Dial Direct tab.
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TO RE-CONNECT TO A REMOTE COMPUTER

1. Select an address to make a connection to the remote computer. You can
select a previously connected remote computer in one of the following ways:

e Select an address from the Address Books tab if you have previously
stored the address in an address book. (See “To save an address to an
address book” on page 56.) If the address book you need is closed, open
it using the procedure on page 57.

e Select a previously-used computer in the Recent Connections tab.

e Onthe TCP/IP tab, the last 20 connections you made are saved to the
TCP/IP Address drop-down list. Select a TCP/IP address from the list and
choose a service.

e Onthe Dial Direct tab, the last 16 telephone numbers you dialed are
saved to the Phone Number drop-down list. Select a number from the
Phone Number drop-down list and click Dial.

2. Onceyou have selected an address, click a service button to connect using
the chosen service. Or right-click the address to open a submenu from which
you can choose the service to launch. If you select multiple addresses, the
same service is invoked for each of the selected addresses.

Note: Double-clicking an entry in an address book or on the Recent Connec-
tions tab launches the default service selected for the remote computer. You
can also select the computer and press ENTER.

USING THE ADDRESS BOOKS

An address book is a collection of Timbuktu Pro addresses. You can add and de-
lete addresses at any time. Each address includes the computer name, its IP ad-
dress, the default service (the service that will be used when you double-click the
address), and a description of the address. You can have multiple address books.

When an address appears in an address book, it does not guarantee that the
computer at that address is currently running Timbuktu Pro. If Timbuktu Pro is not
running on the remote computer, or if the computer is shut down, you will not be
able to connect.

In addition, some TCP/IP addresses may change. They can be automatically re-as-
signed to computers other than the ones appearing in your address books. If your
organization uses dynamic TCP/IP addressing, you may not want to store IP ad-
dresses in Timbuktu Pro’s address books.
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To SAVE AN ADDRESS TO AN ADDRESS BOOK

1. On the Recent Connections tab, select the address you wish to save and click
the Copy to Address Book button. Or, on the TCP/IP tab, enter the IP address
(or email address) you wish to save, and click the Copy to Address Book
button.

2. Inthe Copy dialog box, select the address book to which you want to copy the
address. Click OK.

The address will be saved to the selected address book.

Note: You cannot save Dial Direct phone numbers or LDAP search results to
an address book.

To CHANGE THE PROPERTIES OF A SAVED ADDRESS

1. Inthe main Timbuktu Pro window, click the Address Books tab.

2. Selectan address book from the Address Book drop-down list. The address in
the selected address book appear in the Address List box.

3. Right-click an address to display a shortcut menu.

Timbuktu Pro 4 send... Ctrl+S

Exchange... Ctr+E

Copy To... Ctrl+Y
) Control...  Ctr+T

Properties Alt+Enter Observe... Ctrl+0O

Create Shortcut on Desktop

Delete Del Notify... Ctri+N
Chat... Ctri+A
Intercom... Ctrl+M
Invite... Ctri+1

e Choose Timbuktu Pro to access any of the Timbuktu services. If multiple
addresses are selected, the service is invoked once for each address that
is selected.

e Choose Copy To to copy the selected address into another address book.
You can select the destination address book from the list of open
address books in the Copy window. Or choose New Book to create a new
address book.

e Choose Properties to modify the description, address, and default ser-
vice for the selected entry. The Properties dialog box appears.

e Choose Create Shortcut on Desktop to create a shortcut on the desktop
for the selected address.

e Choose Delete to delete the selected address from the address book.
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To OPEN AN ADDRESS BOOK

1. From the File menu, choose Open Address Book. The Open File dialog box
appears.

2. Select an address book (a file with a .tbk extension) and click Open. The
selected address book is added to the Address Book drop-down list on the
Address Books tab in the main Timbuktu Pro window.

TO CREATE A NEW ADDRESS BOOK

1. On the Recent Connections tab, select any address and click the Copy to
Address Book button. Or, on the TCP/IP tab, enter any IP address (or email
address), and click the Copy to Address Book button.

2. Inthe Copy dialog box, click the New Book button.

3. Inthe New [Address Book] dialog box, in the File Name area, enter a name for
the new address book. Then click Save.

4. The new address book is created and is shown in the Copy dialog box. To
save the address you selected in step 1 to the new address book, click OK. To
keep the new address book without saving the selected address to it, click
Cancel.

MAKING A DIAL DIRECT CONNECTION

The Dial Direct tab in the main Timbuktu Pro window allows you to make a direct
modem-to-modem connection to another Timbuktu Pro computer equipped with
a modem.

When using Dial Direct, no TCP/IP network connection is required. However, Dial
Direct connections use the TCP/IP protocol. You must have TCP/IP networking
software installed and configured on your computer.

Use the text boxes and drop-down lists to enter the complete phone number you
wish to dial. The 16 most recently dialed numbers are saved in the Phone Number
drop-down list. You cannot save Dial Direct numbers to the Recent Connections or
Address Books tab.

Note: The Dial Direct tab appears only if a Windows-recognized modem is
installed in your computer.
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To ESTABLISH A DIAL DIRECT CONNECTION

1. Inthe main Timbuktu Pro window, click the Dial Direct tab.

= Timbuktu Pro - Flyer

Fle Edit View Setup Services Connections Help

G B IS § @

Send Exchange Control Observe  Notify Chat  Intercom  Invite
(S]] address l Recent Q TCR/IP %LDAP Dlal
Connections “ Direct

Books
Type in the phone number of the remote
computer you wish to connect to.

Country Code: | United States (1) |

Area code: 555 h

Phone number: | 555-1212 ~| Dl
Dial: 1 555 555-1212

Dialing from: |M',r Location ﬂ Dialing Properties...

|

Ready My Address : 12.68.1.100

| S

2. Choose a country code from the Country Code drop-down list. (This list is

maintained by the Windows 0S.)

3. Enterthe area code in the Area Code box. If you have connected to phone
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numbers in this area code before, you may choose the area code from the
drop-down list. If you do not enter an area code, Timbuktu Pro assumes that

you are making a local call and will not dial an area code.

4. Enterthe phone numberin the Phone Number box. If you have dialed this

number before, you may also choose it from the drop-down list.

The complete phone number is displayed at the Dial line exactly as it will be
dialed. If you used Dialing Properties to disable call waiting or enable a dial-
ing prefix, the appropriate dialing sequence will be displayed preceding the
number. See your Windows or modem documentation for more information

about setting options in the Dialing Properties dialog box.
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5. Choose Dial to dial the number and begin a Dial Direct connection. The
Modem Status window will appear to help you monitor your connection. For
more information about the Modem Status window, see the online Help.

6. Once the connection is established, you may launch any Timbuktu Pro ser-
vice normally, except Intercom. All services work in the same way as they do
over a TCP/IP connection.

TIMBUKTU PRO CONNECTION DOCUMENTS

Timbuktu Pro Connection Documents are desktop shortcuts that allow you to start
a Timbuktu Pro connection to a specific remote user by double-clicking a desktop
icon. You may also right-click the Connection Document to display a shortcut
menu. Choose Timbuktu Pro » Any Service to establish a connection using the
chosen service.

=

Print
Timbuktu Pro 4 10.72.49.49 (Control)
Open With... Send
Send To |  Exchange
Control
Cut Observe
Copy Notify
Chat
Create Shortcut
Intercom
Delete :
Invite
Rename
Properties

TO CREATE A NEW CONNECTION DOCUMENT
There are several ways to create a new Connection Document.

e Specify a remote computer on the Address Books, Recent Connections, or
TCP/IP tab in the main Timbuktu Pro window. Then click the Edit menu and
choose Create Shortcut on Desktop.
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e Specify a remote computer in the Address Books, Recent Connections, or
TCP/IP tab. Then type CTRL+D.

e Right-click on your desktop and choose New » Timbuktu Pro Connection
Document. You will need to specify an address before you can use the new
Connection Document.

Once the shortcut is created, you can rename it by right-clicking on it. From the
shortcut menu, choose Rename. Do not change the .tmb extension.

If you wish to change the address or default service of one of your Connection
Documents, or if you created it without specifying a remote computer, you will
need to change its properties.

TO CHANGE THE PROPERTIES OF THE CONNECTION DOCUMENT

1. Right-click the Connection Document. From the shortcut menu, choose Prop-
erties. The Properties dialog box appears.

2. Click the Timbuktu Pro Properties tab.

General | Timbuktu Pro Properties | Security | Summary

Connectto remate computer using...

Address: |1n.?2.49.49

v UseSSH: |admin

Double-click connects to this address using:

Default Sensdice: |CDntrDI ﬂ

MOTE: The S5H contact infarmation has this syntas:
[usemarme [[Essh_host] [ssh_pon]]

The default username is wour lagin name. The default
ssh_hostis the same as entered in the Address field.

[ ok [ cancel |[ appy |

3. Enter or modify the remote computer address in the Address field.
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4. To establish sessions with SSH, select the Use SSH checkbox and enter your
user name for the remote computer.

5. Modify the Default Service by choosing a service from the drop-down list.



CHAPTER 5: THE TIMBUKTU PRO SERVICES

This chapter introduces you to each of the many Timbuktu Pro services: Send, Ex-
change, Control, Observe, Notify, Chat, Intercom, and Invite. (The Control and Ob-
serve services are collectively known as Remote Control.) Each Timbuktu Pro
service allows you to interact with remote computers in a different way; together,
they help you make the most of your network.

SEND: SENDING FLASHNOTES AND FILES TO REMOTE COMPUTERS

Timbuktu Pro’s Send service can send messages similar to electronic mail, called
FlashNotes, to another computer. You can also attach files and folders to the mes-
sages and send them to other computers easily.

Timbuktu Pro temporarily stores the files you send in a specific folder on the re-
mote computer. Likewise, remote users can send files only to your files received
folder, which you specify on the Send tab in the Preferences dialog box.

Send does not allow remote users to see the folders on your computer. Once you
receive the files, you can save them to any directory you wish.
To SEND A FLASHNOTE TO A REMOTE COMPUTER

1. Select the remote computer or establish a Dial Direct connection. (See
“Chapter 4: Making a Timbuktu Pro Connection.”)

2. From the Services menu, choose Send. Or click the Send service button. The
FlashNote window is displayed. (Note that you may need to ask for permis-
sion or log in as a Registered User before the window opens.)

|62
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¥ FlashNote

To: |10.36.36.21

Message: | Eric: Here are the files we discussed yesterday. Please let me
know if you'd like any changes. Thanks.

Files: (L1 C:\Business Plan
C:\Denver Presentation.ppt

Help Add Files... ‘ Cancel ‘ Send |

|N0 files attached.

To send a note, type a message in the upper panel.
To include files with your message, click the Add Files button.

You may also drag and drop files and folders from the desktop or from Win-
dows Explorer into the Files area in the FlashNote window.

In the Add Files to Send dialog box, locate and display the source folder in
the upper panel.

Select the files you want to add in the upper panel and click the Add button.
The files that you select in the upper panel appear in the lower panel. If you
wish to remove a file that you added, select the file in the lower panel and
click the Remove button.

Note: You may also drag and drop files and folders from the desktop or from
Windows Explorer into the lower panel of the Add Files to Send dialog box.

Click the Done button when you have finished selecting files.

Click the Send button in the FlashNote window to send the FlashNote and
files.

To stop a file transfer immediately, click the Cancel button. Timbuktu Pro
stops the file transfer, but the FlashNote is still sent to the remote computer.
In addition, stopping the file transfer does not affect files that have already
been transferred.
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When you receive a FlashNote, you may wish to save the FlashNote and any at-
tached files.

To SAVE FLASHNOTES AND FILES

1. Inthe FlashNote window, click the Save Files button. The Save Files dialog
box appears.

2. Select the target drive and the destination folder.

3. Inthe lower panel, select the files or folders you wish to save in this location.
Click the Save button.

You may save each file and folder in a different location. When all of the files
have been saved, or when you click Done, the FlashNote window reappears.

4. |If desired, print or save the FlashNote by clicking the Print Note or Save Note
button.

FlashNotes are saved with a default .rtf extension.
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Exchange: Copying and Moving Files Between Computers

|65

With Timbuktu Pro’s Exchange service, you can copy and move files and folders in
both directions between your computer and another Timbuktu Pro computer. Ex-
change provides more flexibility than Send.

To COPY FILES AND FOLDERS BETWEEN COMPUTERS

1.

= Exchange Files with RAIN

File  View
Flyer

Local Drives: | =

Select the remote computer or establish a Dial Direct connection. (See
“Chapter 4: Making a Timbuktu Pro Connection.”)

From the Services menu, choose Exchange. Or click the Exchange service but-
ton. The Exchange window is displayed. (Note that you may need to ask for
permission or log in as a Registered User before the window opens.)

L OX

[ TB2ADAUthULl.exe
TB2Computer.adm
TimbuktuPro.msi

RSPARLING

Remoate Drives: | ‘A netOctopus Agent

<] il

(1 Admiff NACpIModu.dil
[ Log NALDDO.dII

(1 Modules NAMsg.dll
CharConversion.dll [ Nant.exe

[ peinstall.exe NANT Auth.dll

[ ExecStub. exe [ NANT Secc.exe
ModuleUtils.dIl Mantspas.dil
NACpIMod.dIl Nantspnt.dl

nantsys.sys
™1 NASpawne.exe
[ NASPWN16.EXE
naswdiff.ini

Close

The upper panel lists the drives, folders, and files on your computer. The
lower panel lists the same information for the remote computer.
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3. Locate and display the source and destination folders in the Drives drop-
down lists.

You can use the Create New Folder button create a new destination folder.

4. Dragthe desired files or folders from the source panel to the desired folderin
the destination panel.

5. Timbuktu Pro begins to transfer the files immediately. The Exchange Files dia-
log box appears, indicating the progress of the file transfer.

While Timbuktu is transferring the files, you can

e Click outside the Exchange window, or minimize it, to work on other com-
puter tasks.

e (lick Cancel to immediately cancel the transfer. The file being sent when
Cancelis clicked is not transferred, but any files that were previously sent
remain in the destination folder (unless you manually delete them).

6. When you have finished exchanging files, click the Close button.

You can also use the Exchange service while controlling or observing a Tim-
buktu Pro computer.

REMOTE CONTROL: CONTROLLING OR OBSERVING A REMOTE
COMPUTER

You can use Timbuktu Pro to control or observe a remote computer. The desktop
of the remote computer is displayed in a window on your screen. The window is
updated as the other computer’s desktop changes.

While you are controlling another computer, you can perform any of the tasks that
you could perform locally, including opening applications and creating new files.
This means that a user with the Control privilege can remotely create, modify, or
delete files without restriction, and can erase data from the host computer. This
privilege, therefore, should be granted with caution.

While observing another computer, you can see the activity on its screen, but you
cannot control it. This privilege is useful for diagnosing problems on a remote
computer or giving a presentation.

If the remote computer’s screen resolution is higher than yours and you maximize
your Control or Observe window, the AutoScroll feature is enabled so that you can
view the entire remote desktop.
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TO CONTROL OR OBSERVE ANOTHER COMPUTER

1.

Select the remote computer or establish a Dial Direct connection. (See
“Chapter 4: Making a Timbuktu Pro Connection.”)

From the Services menu, choose Control or Observe. Or click the Control or
Observe service button.

Timbuktu Pro displays the remote computer’s desktop in a screen-sharing
window. (Note that you may need to ask for permission or log in as a Regis-
tered User before the window opens.)

e Ifyou have chosen the Observe option, you will be able to observe the
screen only.

e Ifyou have chosen the Control option, you can use your mouse and key-
board to operate the remote computer.

e Ifthe user of the remote computer has enabled the Use Capture Frame
option in the Preferences dialog box, the screen-sharing window will be
blank until the remote user clicks the Play button in the Capture Frame.
(For more information about the Capture Frame, see “Enabling the
Remote Control Capture Frame” on page 28 and “Using the Capture
Frame” on page 70.)

¢ C(lick on a screen-sharing window to make it the active window. If you are
controlling more than one computer, only the active window will be
affected by your actions. To return to your own computer, click outside
the screen-sharing window.

During your session, use the screen-sharing window’s system menu to
change screen-sharing window settings. To open the system menu, click the
Control or Observe icon in the upper-left corner of the screen-sharing window.
(See “The Screen-Sharing System Menu” on page 68 for more information.)

To stop controlling or observing, open the system menu and choose Close.
Timbuktu Pro closes the window and ends the connection.

If the screen-sharing window doesn’t open, you may have one of the following
problems:

You have not been granted permission to use the Control or Observe service
on the remote computer.

Timbuktu Pro is not running on the remote computer.

There is a network firewall between the computers.

If the screen-sharing window appears, but remains blank, the user of the remote
computer may have enabled the Use Capture Frame option. Unless the remote
user is present at the computer and allows the screen-sharing session to pro-
ceed, you will not be able to view the remote computer.
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If a remote user is controlling or observing your computer while Timbuktu Pro is
minimized, the regular Timbuktu Pro icon in the system tray on the taskbar is re-
placed with an icon that alternates between the regular Timbuktu Pro icon and a
service icon that indicates you have a remote user controlling or observing your
computer.

Note: If you want to enable or disable the Control or Observe service on your com-
puter, you can do so in the Security dialog box. See “Chapter 6: Security” for
information on granting services to remote users.

While controlling or observing a remote computer, you can start another Timbuktu
connection to the same computer. Open the screen-sharing window’s system
menu (click the Control or Observe icon in the upper-left corner of the screen-
sharing window) and choose another service.

Note: Timbuktu Pro does not support full-screen DOS sessions. Press ALT+ENTER
to switch the MS-DOS session from full-screen to windowed mode.

THE SCREEN-SHARING SYSTEM MENU

The screen-sharing window’s system menu includes a number of options to con-
trol settings for the screen-sharing window.

To open the system menu, click the Control or Observe icon in the upper-left cor-
ner of the screen-sharing window.

e Choose Always On Top to force the screen sharing window to remain on top of
all other application windows.

e Choose Logical Keyboard to use logical keyboard mapping if the host and
guest computers use different keyboard types. For example, if the host com-
puter uses a Qwerty keyboard and the guest computer uses a Dvorak key-
board, pressing the Y key on the guest computer will have the same effect as
pressing the Y key on the host computer.

e Choose Show Scrollbars to display scroll bars in the screen sharing window.
(When the screen-sharing window is maximized, scroll bars will not appear,
even when this option is selected.)

e Choose Sync Lock States to match the CAPS LOCK, NUM LOCK, and SCROLL
LOCK settings on the host computer to the settings on the guest computer.
This matching occurs as soon as you press a key while the screen-sharing
window is in focus.

Or choose the Host Settings option to open a dialog box with many of the guest
computer screen-sharing options.
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THE HOST SETTINGS DIALOG BOX

With the Host Settings dialog box, you can change your guest preferences on the
fly, during an active screen-sharing session.

To open the Host Settings dialog box, open the screen-sharing window’s system
menu and choose Host Settings. (The Host Settings option is available only when
the screen-sharing host is a Windows computer.)

Note: Changes you make in the Host Settings dialog box apply only to the active
screen-sharing session. They will not be applied to subsequent screen-sharing
sessions.

Host Settings

[ Blank Screen Ok
[+ Disahle desktop wallpaper Cancel
[v" Disahle Active Desktop

4l

Hel
[+ Disahle apimations =P

[+ Disahble full window drag

[+ Disahle screen sawver

Filter:

||_DSS-|BSS -

e Select Blank Screen to activate secure screen blanking. Secure screen blank-
ingis a Timbuktu Pro security feature that prevents unauthorized viewing of a
computer’s screen while it is being controlled by a remote user. See “Secure
Screen Blanking” on page 28. (The Blank Screen option will be available only
if the host computer allows you to force the screen to blank.)

e Select Disable Desktop Wallpaper to remove the Windows wallpaper from the
remote computer’s desktop while you control or observe the computer.

e Select Disable Active Desktop to disable Active Desktop on the remote com-
puter while you control or observe the computer.

e Select Disable Animations to disable desktop animations on the remote com-
puter while you control or observe the computer.

e Select Disable Full Window Drag to disable full window drag (in which the
window’s contents are displayed while it is dragged) on the remote computer
while you control or observe the computer.
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e Select Disable Screen Saver to prevent the screen saver from running on the
remote computer while you control or observe the computer.

e Select an option from the Filter drop-down list to force a color-depth reduc-
tion before screen-sharing data is sent from the host computer to your
computer.

During your remote-control session, Timbuktu Pro checks the Filter setting on
both the host and guest computer. The more restrictive (faster) setting is
used. (If the host computer is hosting multiple guest connections simulta-
neously, the most restrictive Filter setting is used for all sessions.)

Note: If these settings are not enabled on the host computer, but enabled on the
guest computer, the guest settings will be used during the screen-sharing ses-
sion. However, if these settings are enabled on the host computer, the guest com-
puter cannot disable them. If the host computer is hosting multiple guest
connections simultaneously, the settings for all guest computers are “com-
bined,” and the same settings are used for each connection.

USING THE CAPTURE FRAME

When the Use Capture Frame option is enabled, the screen-sharing window on
the guest computer displays only the portion of the host computer’s desktop that
appears within the Capture Frame on the host computer.

USING THE CAPTURE FRAME AS A GUEST

To begin any outgoing Control or Observe session, launch the service normally.
The screen-sharing window will open on your desktop (you may need to login as
a Registered User or ask for permission first).

If the Use Capture Frame option is enabled on the host computer, the screen-shar-
ing window will be blank until the user of the host computer clicks the Play button
in the Capture Frame. Once the session begins, the screen-sharing window will
display only the portion of the host computer’s desktop that appears inside the
Capture Frame. The user of the remote computer may move or resize the Capture
Frame at any time. You will be able to use the Control and Observe services nor-
mally, except you will not be able to move or resize the Capture Frame even if you
are controlling the remote computer.

If the Use Capture Frame option is not enabled on the host computer, the screen-
sharing session will proceed automatically.
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USING THE CAPTURE FRAME AS A HosST

If the Use Capture Frame option is enabled on your computer and a remote user
begins an incoming Control or Observe session, the Capture Frame will appear on
your desktop. Click the Play button in the upper-left corner of the Capture Frame
to allow the Control or Observe session to proceed. (Until you click the Play but-
ton, the screen-sharing window on the remote computer is blank.)

During the screen-sharing session, only the portion of your desktop that appears
in the Capture Frame is displayed on the remote computer. You may increase or
decrease the size of the Capture Frame or move the Capture Frame around your
computer’s desktop. The remote user will not be able to move or resize the Cap-
ture Frame, even with the Control service.

To close the incoming connection, close the Capture Frame.

If the Use Capture Frame option is not enabled on your computer, any incoming
screen-sharing sessions will proceed automatically, subject to the security con-
trols you have placed on your computer.

SENDING CTRL+ALT+DEL To A REMOTE COMPUTER

If you’re connecting to a computer that is running a secure Windows operating
system, and need to log on, you’ll need to open the Logon Information dialog box.
It’s not possible to do this simply by pressing the CTRL+ALT+DEL keys on your
computer. You’ll need to follow the steps below.

To DISPLAY THE WINDOWS LOGON INFORMATION DIALOG BOX

1. Control the remote Windows computer.

2. Click the system-menu button (the Control or Observe icon in the upper-left
corner of the screen-sharing window) and choose Send Ctrl+Alt+Del to
Remote Computer.

The Logon Information dialog box is displayed on the remote computer,
allowing you to enter your user name and password.

You don’t have to log on to Windows to use Timbuktu Pro with a secure Windows
computer. You can exchange files with and send files to a remote computer when
the Logon Information dialog box is displayed. However, FlashNotes are not dis-

played on the Windows system until after you have logged on.
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CONTROLLING A MACINTOSH COMPUTER

Controlling a Macintosh computer is usually identical to controlling a Windows
computer. However, their keyboards are slightly different. If you need to send a
Command (38) keystroke to the Macintosh, press the Window key on your Win-

dows computer.

When you control a Macintosh, the Map Ctrl-> Cmd option appears on the system
menu in the screen-sharing window. (To open the system menu, click the Control
or Observe icon in the upper-left corner of the screen-sharing window.) If you en-
able this option, pressing CTRL on your Windows keyboard will send the equiva-
lent of a Command keystroke to the Macintosh. If you disable this option,
pressing CTRL on your Windows keyboard will send CTRL to the Macintosh.

NOTIFY: REQUESTING NOTIFICATION WHEN THE REMOTE USER IS

ACTIVE

Timbuktu Pro’s Notify service lets you leave a request to be notified when another
Timbuktu Pro computer becomes active. This is a useful way to find out when the
person you want to communicate with is available. You can then call or begin a
Chat or Intercom session with the user of the remote computer.

TO REQUEST NOTIFICATION OF ANOTHER USER’S PRESENCE

1. Select the remote computer or establish a Dial Direct connection. (See
“Chapter 4: Making a Timbuktu Pro Connection.”)

2. From the Services menu, choose Notify. Or click the Notify service button. The
Notify window is displayed. (Note that you may need to ask for permission or
login as a Registered User before the window opens.)

P | Notifying RAIN

Cancel

?/ Waiting for an answer...
Idle 00:00:01:40

Help

Last Active:
Wednesday, January 19 2005, 02:22 PM (Local Time)
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“Waiting for an answer” appears near the top of the window. Below it are the
following fields:

e /dle Time tells you how much time has passed since the remote user has
used that computer.

e lastActive tells you the date and time the remote user last moved the
mouse or pressed a key. This field changes to Became Active the next
time the remote user moves the mouse or presses a key, and displays
the new date and time.

While you’re waiting, you can work on tasks in other windows. You can mini-
mize the Notify window, but don’t close it.

On the remote computer, the Request for Notification dialog box tells the
remote user that you are asking for notification.

Note: If the remote user has selected Answer Automatically on the Notify tab
in the Preferences dialog box, the Request for Notification dialog box does
not appear. You will be notified immediately when the remote computer
becomes active.

l RAIN is asking to be notified...

\_:/; RAIN is asking to be notified Acknowledge
Address: 19.16.10.10

Wait 00:00:00:15 Ignore

i

Send ‘ Exchange ‘ Help
Control ‘ Observe ‘
Chat ‘ Intercom ‘

When the remote user clicks Acknowledge in the Request for Notification dia-
log box, the message in your Notify window changes to “Name is there.”

P | Notifying RAIN EIIEI@

!‘_\ RAIN is there. OK
.

Help

_ o |
v |
oy sgon |

Became Active:

Wednesday, January 19 2005, 02:27 PM (Local Time) . _
Notify Again

Chat

Intercom
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The remote user also has the option of clicking the Chat, Intercom, or Ignore but-
ton. If the remote user clicks the Ignore button when you ask for notification, the

Notify window on your computer will remain unchanged, even though the remote
user has become active.

Once you have been notified of the remote user’s return, you can close the Notify
window and call the other user, or you can use any of the additional buttons that
are now displayed—Notify Again, Chat, or Intercom.

If the Notify window is acknowledged while you are away from your computer, the
remote user may no longer be at their computer by the time you get back. You can
start the notification process again by clicking the Notify Again button.

If you want to initiate a keyboard conference or a voice communication with the
other user, click the Chat or Intercom button.

CHAT: CHATTING WITH A REMOTE USER

The Chat service lets Timbuktu Pro users and their guests post messages to one
another interactively. For example, if you are already in the midst of a file transfer
session, a Chat session lets you discuss the file transfer with the other user.

TO CHAT WITH A REMOTE USER

1. Select the remote computer or establish a Dial Direct connection. (See
“Chapter 4: Making a Timbuktu Pro Connection.”)

2. From the Services menu, choose Chat. Or click the Chat service button. The
Chat window is displayed. (Note that you may need to ask for permission or
log in as a Registered User before the window opens.)
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© Chat with RAIN gg

< Flyer =: Hi, Eric. Did you get the files you sent?

I'm hoping to receive comments by

Disconnect ‘ Erint | Save ‘ Help ‘

Connected

Type your first message and press ENTER or click the Send button.

Your message is copied to the transcript panel in the upper part of the win-
dow and to the Chat window on the remote computer. Type more messages
immediately or wait for a reply from the other user.

5. Thereplyis displayed below your message in the transcript panel. You can
keep typing messages back and forth as long as you like.

6. When you’ve finished chatting, click the Disconnect button. When either
party disconnects, the session is ended, and the message at the bottom of
the window changes to Disconnected.

7. After you have disconnected, you can print or save the chat-session details.

e  (Click Print to print the chat-session details.
e Click Save to save the chat-session details to a rich text file (with an .rtf
extension).

8. Click the Close button in the upper-right corner to close the Chat window.
You can chat with more than one other user at the same time, but you will need to

open a separate Chat session with each participant. For this reason, you cannot
chat with multiple users over a Dial Direct connection.



Intercom: Speaking to a Remote User |76

INTERCOM: SPEAKING TO A REMOTE USER

The Intercom service lets Timbuktu Pro users talk to each other through their com-
puter's audio hardware.

The Intercom service is not available over Dial Direct connections.

To SPEAK TO ANOTHER TIMBUKTU PRO USER

1. Select the remote computer. (See “Chapter 4: Making a Timbuktu Pro Con-
nection.”)

2. From the Services menu, choose Intercom. Or click the Intercom service but-
ton. The Intercom window is displayed. (Note that you may need to ask for
permission or log in as a Registered User before the window opens.)

& Intercom with RAIN Q|E|B|
i 2

Speaker Volume: — Ji High
Talking Threshold: — )— High

[ Mute Mike
[ Using Headphones or Handset (Full Duplex)

Sound Compression:

|Hone (ISDN/LAN Connection, 64kbs) ~|
Receiving: G5M Compression
Network 100% Transmit
100% Receive
Status: Idle
Help ‘ Close ‘

Note: If the sound card on your computer or the remote computer is already

being used by another application—for example, recording or playback—you
won’t be able to begin your Intercom session until the other application has

been closed.
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When the Intercom window is displayed, you can begin speaking with the
remote user.

Note: The Intercom window does not automatically stay on top of the screen
when other application windows are run in the foreground.

When you’ve finished talking, click Close.

INVITE: INVITING A REMOTE USER TO ACCESS YOUR COMPUTER

The Invite service allows you to invite other users to access your computer. Once
you have specified a remote computer to receive your invitation, you can select
the type of invitation you want to extend and send it to the remote user. Awindow
opens on the remote computer, inviting the remote user to begin the Timbuktu
Pro session. The recipient will be able to connect to your computer using the ser-
vice you specify, or decline your invitation by closing the Invite window.

To INVITE A REMOTE USER TO ACCESS YOUR COMPUTER

1.

2.

Select the remote computer or establish a Dial Direct connection. (See
“Chapter 4: Making a Timbuktu Pro Connection.”)

From the Services menu, choose /nvite. Or click the /nvite service button. The
Invite window is displayed.

Invite S|

@ Invite RAIN to connect with service:

Send ‘ Exchange ‘
Control ‘ Observe ‘
Chat ‘ Intercom ‘

In the Invite window, click a service button to specify the service you wish to
invite the other user to access.

Depending on the remote computer’s settings, you may need to ask for per-
mission or log in as a Registered User before the Invite process continues.
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4. The Invite window appears on the remote computer, indicating the service
you invited the remote user to use.

You have been invited

The user of RAIN invites you Start Session
to an exchange session.

Cancel
Do you wish to start this session?

The remote user may click Start Session to launch the Timbuktu Pro service or
Cancel to close the Invite window.

Note: On Macintosh computers, the service window opens automatically. The
Macintosh user may begin using the service or close the window to cancel it.

When the remote user accepts the invitation and the Timbuktu Pro service is
launched, the remote user's computer becomes the guest computer and the local
computer becomes the host computer. Normally, when you launch a Timbuktu Pro
service, your local computer is the guest computer.



CHAPTER 6: SECURITY

Timbuktu Pro offers multiple levels of security that help you restrict access to the
different Timbuktu Pro services on your computer. Remote Timbuktu Pro comput-
ers can connect to your computer as several kinds of remote users: Guest Users,
Registered Users, Ask For Permission Users (or temporary guests), and Windows
NT Users (Windows NT-based hosts and guests only). Each kind of user can be
granted different levels of access.

Timbuktu Pro will alert you when remote users access your computer. The Tim-
buktu Pro icon in the system tray on the taskbar alternates with a service icon in-
dicating the presence of a remote user. You can disconnect remote users at any
time.

The activity log keeps a record of all remote computers that access your computer,
along with the services used. Finally, you can use a Timbuktu Pro master pass-
word to prevent a user with direct access to your computer from changing any of
your Security, Preferences, or LDAP settings.

TIMBUKTU PRO REMOTE USERS

Timbuktu Pro allows you to specify many different levels of remote-user access.
You can allow all users to access certain services, and limit other services to pass-
word-authenticated users.

Guest User access is available to all remote Timbuktu Pro users. You do not have
to assign any services to Guest Users, or you can select specific Timbuktu Pro ser-
vices you wish to make available to them. A Guest User does not have to supply a
user name or password to access the services you have assigned to guests.

Guest Users are normally assigned a limited range of services because guest ac-
cess is open to anyone without authentication. Services such as Send and Notify
are often assigned to guests; services such as Control and Exchange are almost
never assigned to guests. By default, Guest Users are granted the Send and Notify
services.
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If you enable the Ask For Permission option, a guest who does not have permis-
sion to use a particular service can request permission to use that service on a
one-time-only basis. If a remote user attempts to connect to your computer using
a service he or she has not been granted, a dialog box will appear on your screen
giving the name of the remote computer and specifying the service the user
wishes to access. (You may also require individual Registered Users and Windows
NT Users to ask for permission after they are authenticated.) See “Ask for Permis-
sion Access” on page 90.

The Admit Temporary Guest feature is similar to the Ask for Permission feature
and is provided for compatibility with earlier versions of Timbuktu Pro.

Registered Users must supply a user name and password to access your com-
puter. You can create a Timbuktu Pro account for as many Registered Users as you
wish, and assign each user a specific set of access privileges. A Registered User
can access the services you have assigned to the Registered User account any-
time Timbuktu Pro is running on your computer.

Registered User status on one computer does not give the user the ability to con-
nect to any other remote computer. Access to Timbuktu services is granted on a
computer-by-computer basis.

Windows NT Users are the users and user groups on your Windows network who
have been granted permission to use specific Timbuktu Pro services on your com-
puter. The Windows NT Users you create are similar to Registered Users, but—
because they have already been authenticated by logging in to the Windows
network—they do not need an additional password to access your computer.

Note: Privileges granted to Guest Users are automatically granted to Registered
Users and Windows NT Users. You cannot withhold a privilege from a Registered
User and Windows NT User if that privilege is granted to guests.
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THE SECURITY DIALOG BOX

The Security dialog box controls the security configuration for your computer.
There are three tabs in the Security dialog box: Guests, Registered Users, and NT
Users. These tabs allow you to

e Specify which Timbuktu Pro Services will be available to Guest Users.

e Specify whether guests will be able to ask for permission to use services you
haven’t assigned them.

e (Create, modify, and remove Registered User accounts.

e Set password restrictions for Registered User accounts.

e Assign privileges to Windows NT Users (including users of Windows 2000,
Windows XP Pro, and Windows 2003).

The following sections describe how you can use the Security dialog box to con-
figure Timbuktu Pro security.

If a master password is specified for your computer on the Master Password tab in
the Preferences dialog box, you’ll have to supply the master password to access
the Security dialog box. (See “Setting Up Your Master Password” on page 36.)

MANAGING TIMBUKTU PRO USERS

Before other computers can use Timbuktu Pro to connect to your computer, you
must assign privileges to Guest Users, Registered Users, or Windows NT Users.

ASSIGNING SERVICES TO GUEST USERS

A service assigned to Guest Users is available to anyone who connects to your
computer using Timbuktu Pro. Remember to exercise caution when granting a ser-
vice to Guest Users. A Guest User does not have to enter a password to use the
service, and you are not prompted to give permission before the session begins.
However, the Timbuktu Pro icon in the system tray will indicate that a user has
connected to your computer (see “Monitoring Remote Connections” on page 94).
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TO GRANT SERVICES TO ALL GUEST USERS

1. From the Setup menu, choose Security. The Security dialog box appears.

Security B|

Guests ]Registered Users] NT Users]

Check the services you wish to grant to Guests

[v Send | Exchange (Read)
[ Control | Exchange (Write)
[ Observe | Exchange (Delete)
[ Chat [ Intercom

[v Notify [ Invite

[+ Guests may ask for permission to use unchecked services.

OK | Cancel Help

2. Onthe Guests tab, select the services you wish to grant to all Guest Users.

3. Ifyou wish to let remote users ask for permission to use services you have
not assigned to Guest Users, select Guests May Ask For Permission to Use
Unchecked Services.

4. Click OK to save your changes and close the Security dialog box.

You can return to the Security dialog box at any time to change access privileges.

DEFINING REGISTERED USERS

Registered Users must supply a user name and password to access your com-
puter. You can create Timbuktu Pro accounts for as many Registered Users as you
wish, and assign each user a specific set of access privileges. If desired, you can
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require Registered Users to ask for permission after they have been authenticated
but before they can connect to your computer.

A Registered User can access the services you have assigned to the Registered
User account anytime Timbuktu Pro is running on your computer.

When you wish to grant a remote user permanent, password-protected access to
your computer, you will define a Registered User account.
To ADD A REGISTERED USER ACCOUNT

1. From the Setup menu, choose Security. The Security dialog box appears.
2. Click the Registered Users tab.

Security §|

Guests Registered Users lN‘r Users]

Assign user's name and password...
spark
Hame: |sammy
Password: |”***
Confirm |
Check the services to grant
[v | Exchange (Read)
[ Control | Exchange (Write)
Add Registered User [~ Observe [ Exchange (Delete)
— [ Chat [ Intercom
E Registered U v
Remove Registered User ™ Invite
On Host Service Request:
Pagsword Restrictions...
[ Ask For Host Permissior

Default @ no (" yes

in|30 seconds

OK | Cancel ‘ Apply Help

3. Click the Add Registered User button to create a Registered User called “New
User.”

4. Inthe Name text box, enter the user name the Registered User will use to
connect to your computer.
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In the Password and Confirm text boxes, enter the password the Registered
User will use to connect to your computer. The password is case-sensitive.

You will not be able to close the Security dialog box until the text in the Pass-
word and Confirm text boxes matches exactly.

During the log-in procedure, the Registered User is free to change the pass-
word as long as the replacement password conforms to any password restric-
tions you have set. See “Setting Password Restrictions” on page 85.

In the Check the Services to Grant area, select the services you wish to grant
to this Registered User.

Services granted on the Guests tab are automatically granted to all Regis-
tered Users as well. For example, if you grant the Observe service to Guest
Users, you cannot deny this service to Registered Users. It will be dimmed in
the Registered Users tab.

Check the Ask for Host Permission box if you want the option to reject con-
nection attempts by this Registered User.

This allows you additional security beyond Registered User authentication.
After the Registered User’s user name and password are verified, the Ask for
Permission dialog box will appear on your screen. You can click OK to accept
the connection or Cancel to deny it.

Use a Default To radio button to automatically accept or reject the connection
when you are unable to answer the request within the time period specified
in the Seconds box.

If the Registered User attempts to access services you have granted to Guest
Users, you will not be given the opportunity to reject the connection. Guest
User access will be granted automatically.

If the Registered User attempts to connect using a service you have not
granted in the Check Services to Grant area, the attempt will appear as an
Ask For Permission request. (See “Ask for Permission Access” on page 90.)

Click Password Restrictions to enforce password restrictions on the Regis-
tered Users connecting to your computer. For more information, see the fol-
lowing section, “Setting Password Restrictions.”

Click OK to save the new Registered User and close the Security dialog box.
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SETTING PASSWORD RESTRICTIONS
When you click the Password Restrictions button on the Registered Users tab in
the Security dialog box, the Password Restrictions dialog box appears.
Password Restrictions g|
Enforce these password restrictions on users connecting to this computer

[w Passwords can't match the three previous passwords
[w Minimum number of characters in passwords | 4

[+ Number of days until password expires 30

Help oK | Cancel ‘

There are three options that may increase the security of the passwords used by
your Registered Users.

e Passwords Can’t Match the Three Previous Passwords prevents the Registered
User from reusing recently-used passwords.

e Minimum Number of Characters in Passwords requires Registered Users to
choose passwords of a minimum length, which may make them more difficult
to guess.

e Number of Days Until Password Expires requires Registered Users to define
new passwords on a regular basis.

CHANGING OR REMOVING A REGISTERED USER ACCOUNT

If the privileges you have assigned a Registered User become inadequate for your
needs, orif the user no longer requires access to certain services, you may wish to
change the Registered User account privileges. If a Registered User no longer re-
quires access to your computer, you may wish to remove the Registered User ac-
count.

To CHANGE A REGISTERED USER ACCOUNT

1. From the Setup menu, choose Security. The Security dialog box appears.
2. Click the Registered Users tab.

3. Select the desired Registered User from the list on the left side of the dialog
box.
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4. To change the user’s name or password, select it and type the new value. If
you change the password, you will have to type it again in the Confirm field.

5. Select or clear the services you wish to grant or deny.
6. Click OK to save your changes and close the Security dialog box.

To REMOVE A REGISTERED USER ACCOUNT

1. From the Setup menu, choose Security. The Security dialog box appears.
2. Click the Registered Users tab.

3. Select the desired Registered User from the list on the left side of the dialog
box.

Click Remove Registered User to remove the Registered User.
5. Click OK to save your changes and close the Security dialog box.

DEFINING WINDOWS NT USERS

Using the NT Users tab in the Security dialog box, you can assign Timbuktu Pro
privileges to Windows users and groups on Windows NT-based networks.

A Windows NT User account allows a Windows user (or user group) to access Tim-
buktu Pro services on your computer. Because these users are authenticated
when they log in to Windows, Timbuktu Pro does not require them to use an addi-
tional password when they connect to your computer. If desired, you can require
Windows NT Users to ask for permission after they have been authenticated but
before they can connect to your computer.

Note: The NT Users tab in the Security dialog box appears only when you have
privileges to read user/group settings from the operating system.
ADDING A WINDOWS NT USER ACCOUNT

To allow Windows-authenticated users access to your computer, you will define a
Windows NT User account.

To ADD A WINDOWS NT USER ACCOUNT

1. From the Setup menu, choose Security. The Security dialog box appears.
2. Click the NT Users tab.
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Security R|

Guests] Registered Users NT Users l

OPS\drew
OPSY\ Admins

Check the services to grant

[+ Send

[ Control

[ Observe

[v Chat

[v Notify

[ Exchange
[ Intercom
[ Invite

On Guest Service Request:

[w Ask For Host Permission
— Default to (& no (~ yes

Remove in 30 seconds.

oK Cancel Apply Help

3. Click the Add button. The Add Users and Groups dialog box appears.



Add Users and Groups

Managing Timbuktu Pro Users

X|

List Names |@ OPS

Names

W& Accounts
€ alicew
€ drew

Add Names

€ drew

<

Remove

Check the services to grant

[v Send

[ Control

[ Observe

[w Chat

v Hotify

[ Exchange

[ Intercom

[ Invite

v Ask For Host Permission
Defaultto (@ no (" yes

in 30  seconds
OK | Cancel ‘

You can select existing Windows users and groups in the Add Users and

Groups dialog box. You cannot create new users or groups.

Select a Windows domain from the List Names From drop-down list. This will
list the users and groups in the selected domain.

Select a user or group in the Names list and click Add to add it to the Add

Names box.

If you select a user group, you may also choose Members to list the users
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included in the group. You may then add individual members of that group,

or add the entire group.
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Select a Windows user or group in the Add Names box and specify the ser-
vices you wish to grant.

Note: Services granted to all Guest Users in the Guests tab are automatically
granted to all Windows NT Users as well. For example, if you grant the
Observe service to Guest Users, you cannot deny it to Windows NT Users.

Check the Ask for Host Permission box if you want the option to reject con-
nection attempts by the selected user or user group.

This allows you additional security beyond Windows authentication. After
the Windows NT User’s identity is verified, the Ask for Permission dialog box
will appear on your screen. You can click OK to accept the connection or Can-
cel to deny it.

Use a Default To radio button to automatically accept or reject the connection
when you are unable to answer the request within the time period specified
in the Seconds box.

If the Windows NT User attempts to access services you have granted to
Guest Users, you will not be given the opportunity to reject the connection.
Guest User access will be granted automatically.

If the Windows NT User attempts to connect using a service you have not
granted, the attempt will appear to you as an Ask For Permission request.
(See “Ask for Permission Access” on page 90.)

Click OK to close the Add Users and Groups dialog box.
Click OK to close the Security dialog box.

CHANGING OR REMOVING A WINDOWS NT USER ACCOUNT

If the privileges you have assigned a Windows NT User become inadequate for
your needs, or if the user or group no longer requires access to certain services,
you may wish to change or delete the Windows NT User account privileges.

To moDIFY A WINDOWS NT USER ACCOUNT

1.

2
3
4.
5

From the Setup menu, choose Security. The Security dialog box appears.
Click the NT Users tab.

In the User List box, select a Windows NT User.

Select or clear the services you wish to grant or deny.

Click OK to save and close the Security dialog box.
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To DELETE A WINDOWS NT USER ACCOUNT

1. From the Setup menu, choose Security. The Security dialog box appears.
2. Click the NT Users tab.

3. Inthe User List box, select a Windows NT User.

4. Click Remove to remove the Windows NT User account.

Note: Clicking Remove does not delete the Windows user or group from the
network database. It only removes the Windows NT User account from your
list of Timbuktu Pro authorized users.

5. Click OK to save and close the Security dialog box.

ATTENDED ACCESS

For security reasons, you may not wish to assign some privileges to remote users.
When these users require one-time-only access to a certain service, they may con-
nect to your computer as Ask for Permission Users or as temporary guests.

ASK FOR PERMISSION ACCESS

If a Guest User is asking for permission to use a service you have not granted to
guests, the Ask for Permission dialog box will appear on your screen. The same
dialog box will appear if you have enabled the Ask for Host Permission option for
a specific Registered User or Windows NT User. (See “Defining Registered Users”
on page 82 and “Defining Windows NT Users” on page 86.)

Ask For Permission

The following user is waiting for admittance:

RATN

Address: 19.16.10.10 Cancel
Service: Control Help

Timeout and refuse in 16 seconds.

WARNING! You are about to let another user access your computer
via the above mentioned service.

Close any windows that contain confidential information before
allowing Control or Observe.

Exchange will allow the remote user to access the files on your
hard disk, as well as files on any network drives you are currently
logged into.
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The Ask for Permission dialog box provides the name of the computer requesting
the connection and the service that the remote user wishes to use. Click OK to ac-
cept the connection, or click Cancel to deny the remote user’s request.

Note: If you grant Ask for Permission access to a user requesting the Exchange
service, you automatically grant the user access to all Exchange subservices:
Exchange (Read), Exchange (Write) and Exchange (Delete).

ENABLING ASK FOR PERMISSION REQUESTS

If you enable Guests May Ask for Permission to Use Unchecked Services on the
Guests tab in the Security dialog box (see “Assigning Services to Guest Users” on
page 81), remote users can ask for permission to use services that have not been
assigned to Guest Users.

If a remote computer attempts to access a service that has not been assigned to
guests, a Log In dialog box will appear on the screen, asking whether the user
would like to connect as a Registered User (by supplying a name and password)
or as an Ask for Permission user. If the user chooses Ask for Permission, you (the
host) are prompted to approve the connection before the remote user can con-
nect.

Note: You cannot require users to ask for permission to use the Notify service.

To ENABLE REQUESTS BY ASK FOR PERMISSION USERS

1. From the Setup menu, choose Security. The Security dialog box appears.

2. Click the Guests tab. If the service for which you wish to require Ask For Per-
mission access is selected in this tab, deselect it.

3. Ensure the Guests May Ask for Permission to Use Unchecked Services check-
box is selected.

4. Click OK to save your changes and close the Security dialog box.

DISABLING ASK FOR PERMISSION ACCESS

If you decide that a certain service—for example, Control or Exchange—should not
be available to any user at any time, you must remove that service from the list of
guest privileges and from the list of privileges for every user account. You may
also disable the Ask for Permission feature.
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To REMOVE A SERVICE FROM ASK FOR PERMISSION ACCESS

1. From the Setup menu, choose Security. The Security dialog box appears.

2. Click the Guests tab. If the service you want to remove from access is
selected, deselect it. To prevent users from even asking for permission to use
the service, deselect Guests May Ask for Permission to Use Unchecked Ser-
vices. Keep in mind that deselecting the Ask for Permission option may lock
out services you want to keep available for Ask for Permission Users.

3. Click OKto save your changes and close the Security dialog box.

TEMPORARY GUEST ACCESS

The Admit Temporary Guest option allows you to grant temporary access to Tim-
buktu Pro users are who running older versions of Timbuktu Pro. Temporary
guests are similar to Ask for Permission Users, but older versions of Timbuktu Pro
are unable to request access. You must arrange the connection in advance.

To ADMIT A TEMPORARY GUEST

1. Arrange an appointment with the user that wants to connect to your
computer.

2. Atthe appointed time, click the Connections menu and choose Admit Tempo-
rary Guest. The Admit Temporary Guest dialog box appears.



Admit Temporary Guest

R.AIM
Address: 19.16.10.10

Service: Control

I
v Control
v Observe
[ Chat

The following guest is waiting for admittance:

Temporary Guest Privileges

[ Exchange (Read)
[ Exchange (Write)
[ Exchange (Delete)
[ Intercom

My TCP/IP Address: |18.16.10.11

Close any windows that contain confidential information before
allowing Control or Observe,

Attended Access

oK

Cancel

WARNING! You are about to let another user access your computer
via services checked in the box above.

If Exchange is checked, the remote user will be able to access the
files on your hard disk, as well as files on any network drives you
are currently logged into.

gl

Select the services you wish to grant the temporary guest.
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When the temporary guest connects to your PC, the guest computer’s Tim-
buktu name and network address are displayed under The Following Guest is
Waiting for Admittance, along with the access privilege the temporary guest

has requested.

Click OK to begin the attended access session.

You can always deny a session if the unexpected occurs. For example, if a
guest connects with a privilege you are not expecting—if the Control service

is requested instead of Observe—click Cancel to break the connection.
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MONITORING REMOTE CONNECTIONS

There are a number of ways to keep track of and control Timbuktu Pro connections
to your computer. When a remote computer connects, the Timbuktu Pro icon in
the system tray on the taskbar alternates between the application icon and a ser-
vice icon that indicates the service being used. (For a list of icons, see “Icon Leg-
end” on page 103.) Right-click the Timbuktu Pro icon to display a list of current
users and the services they are using. You can disconnect any or all users at any
time.

In addition, the activity log tracks past connections, so you can check on previous
users at any time.

DISCONNECTING ALL REMOTE USERS

If you wish to disconnect all remote users from your computer (for example, you
wish to shut down Timbuktu Pro), click the Connections menu and choose Discon-
nect All Users. Timbuktu Pro immediately terminates sessions with all the remote
users listed below this command.

DISCONNECTING A SPECIFIC REMOTE USER

If you wish to disconnect a specific remote user from your computer (for example,
the user is using a service you did not intend to grant), click the Connections
menu and choose the remote user from the remote user list below the Disconnect
All Users option. Timbuktu Pro immediately terminates the session with the se-
lected remote user.

KEEPING REMOTE USERS OuUT

You can prevent remote users from accessing your computer by removing all Reg-
istered User and Windows NT User accounts and removing all services from Guest
User access. More simply, you can exit and shut down Timbuktu Pro by clicking
the File menu and choosing Exit and Shut Down Timbuktu Pro. If you exit Timbuktu
Pro without shutting down the application (by clicking the File menu and choos-
ing Exit) remote users will still be able to use Timbuktu Pro to connect to your
computer.
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CLEARING THE PREVIOUS USER LIST

The Previous User list consists of names of recent users who are no longer con-
nected to your computer. Those names appear on the Connections menu under
the Clear Previous User Log option, as well as in the system menu (right-click the
Timbuktu Pro icon in the system tray on the taskbar). Remove names from the Pre-
vious User list by choosing Clear Previous User Log from the Connections menu.

Open Connections

Disconnect Al Users Admit Temporary Guest... Ctr+G

S Disconnect RAIN Activity Log...
Clear Previous User List Disconnect All Users
B! = Disconnect RAIN
1

Clear Previous User Log
Admit Temporary Guest... B!
About Timbuktu Pro... !

Timbuktu Pro Scanner

Exit and Shut Down Timbuktu Pro

Timbuktu Pro system menu Connections menu

The names that are listed below the Clear Previous User Log option are deleted.

USING LOG FILES

Timbuktu Pro supports a number of different logging features to allow you to track
and record the Timbuktu Pro activity on your computer. See the following section,
“Timbuktu Pro Logging.”

TIMBUKTU PRO LOGGING

Timbuktu Pro supports a number of different logging features to allow you to track
and record Timbuktu Pro activity.

e The Activity Log maintains a list of the all incoming and outgoing Timbuktu
Pro connections on your computer.

e The Event Log file is a text document which records the same information that
Timbuktu Pro records in the Windows Application Event Log. The text file for-
mat allows you to easily search the log for events you wish to review.

e The Windows Application Event Log also logs guest and host service events.
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Timbuktu Pro also supports two different types of centralized logging for all the
Timbuktu Pro computers on your network:

e The Timbuktu Log Server allows you to copy information from your Timbuktu
Pro activity log or Event Log file to another Timbuktu Pro computer.

e The NT Event Log Server allows you to copy information about Timbuktu Pro
events from your Windows Application Event Log to the Application Event Log
on another Timbuktu Pro computer.

You may also now specify the maximum size for your log files, and you may spec-
ify that certain configuration changes are recorded in the log files.

To set up your logging options, use the Logging tab in the Preferences dialog box
(see page 39). See the following sections for more information about each type of
log.

THE ACTIVITY LoG

The activity log maintains a list of the all incoming and outgoing Timbuktu Pro
connections on your computer. The activity log is a useful record of Timbuktu Pro
activities. You can also use the activity log to diagnose problems you encounter
when using Timbuktu Pro.

Each line of the activity log contains a date, a time, and the activity that was car-
ried out—for example, the Timbuktu Pro application was launched. The activity
log also contains the Timbuktu Pro computer name and IP address of each remote
user that connects to your computer, records when the user connected, and spec-
ifies which services the user accessed. For file transfers using the Send and Ex-
change services, the file name and the local directory involved in the transfer are
logged on both computers. For Exchange file transfers, the guest computer also
logs the remote directory.

Finally, the activity log reports when Timbuktu Pro was loaded, when previous us-
ers were cleared from the Connections menu, and when Timbuktu Pro was shut
down.

At times you may wish to save or print the activity log for your records.
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To VIEW AND SAVE THE ACTIVITY LOG

1.

From the Connections menu, choose Activity Log. The activity log appears.

B Activity Log X

01/19/2005 3:02:14 PM Dial Direct Initiated SPRING -
01/19/2005 3:03:21 PM Ask For Permission - Control Admit RAIN RAIN
01/19/2005 3:03:51 PM Ask For Permission - Control Deny RAIMN RAIN
01/19/2005 3:07:36 PM Temp Guest Dialog Opened

01/19/2005 3:08:18 PM Temp Guest Deny

01/19/2005 4:13:52 PM Guest Invite Begin RAIN Spring 12.16.1.12
01/19/2005 4:14:03 PM Guest Invite End RAIN Spring 12.16.1.12
01/19/2005 4:14:19 PM Ask For Permission - Chat Admit RAIN RAIN
01/19/2005 4:14:30 PM Ask For Permission - Chat Acceot RAIN RAIN
01/19/2005 4:14:30 PM Host Chat Begin RAIN Spring 12.16.1.12
01/19/2005 4:39:03 PM Host Chat End  RAIN Spring 12.16.1.12

b

Help Save As... I Close |

If you’d like to save a copy of the activity log, verify that your computer has at
least 32K of available disk space, then click Save As.

In the Save As dialog box, enter a name for the saved activity log, and select
a destination folder. The activity log is saved in .txt format.

In addition to saving a copy of the activity log, you may edit or print it at any time.

To EDIT OR PRINT THE ACTIVITY LOG

1.

2.

To edit or print the activity log, click Save As in the Activity Log window and
save the log as a text document. The text document can then be opened and
printed by a word processing application such as Notepad, or imported into
a spreadsheet or database document.

Click OK.

The activity log can preserve up to 32K of activity information before it begins to
discard its oldest records.
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THE EVENT LOG FILE

The Event Log file is a text document which records the same information that
Timbuktu Pro records in the Windows Application Event Log. The text file format
allows you to easily search the log for events you wish to review.

THE WINDOWS APPLICATION EVENT LOG

Timbuktu Pro logs guest and host service events to the Windows Application
Event Log.

To see these events in the Windows Application Event Log, open the Windows
Start menu. Choose Programs » Administrative Tools » Event Viewer and choose
the Application option.

USING A MASTER PASSWORD

In many situations it may be possible for multiple users to access your computer
directly by sitting at your workstation. To protect your Timbuktu Pro settings, you
can set a master password on the Master Password tab in the Preferences dialog
box. Your master password prevents unauthorized users from accessing any of
the options on the Setup menu, which is used to change Timbuktu Pro’s configu-
ration and security settings. When you use a master password, Timbuktu Pro will
not allow you to access the Security, Preferences, and LDAP Options dialog boxes
until you enter the correct password.

No one can bypass the master password. If you forget your master password, you
will need to re-install Timbuktu Pro.

See “Setting Up Your Master Password” on page 36 for details on how to set and
change your master password.



CHAPTER 7: TIMBUKTU PRO USER ASSISTANCE

Timbuktu Pro was designed to be as intuitive and easy-to-use as possible. This
manual should answer most of your questions. If you’re still having difficulty, you
can refer to the online Help for more comprehensive information. If you are still
unable to solve your problem after referring to all the documentation, you may
contact Netopia’s Technical Support.

GETTING HELP IN TIMBUKTU PRO

Timbuktu Pro’s comprehensive online Help provides a variety of ways to answer
your questions. It contains step-by-step instructions for all common procedures,
as well as troubleshooting hints, keyboard shortcuts, and a glossary.

You can navigate through the online Help using the Table of Contents, Index, and
hyperlinks between Help topics.

You may also wish to view the Timbuktu Pro Release Notes, which may contain
feature and troubleshooting information that was not available at the time this
document was created.

OPENING TIMBUKTU PRO’S ONLINE HELP

In the main Timbuktu Pro window, click the Help menu and choose Contents. Or
press F1 from anywhere within Timbuktu Pro for context-sensitive Help. If a Help
button is available in a window or dialog box, click it to display the online Help
topic associated with that area of the user interface.
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CONTACTING NETOPIA

If you require technical support, please browse Netopia’s Technical Notes and
Frequently Asked Questions, available 24 hours a day on our Web site at
http://www.netopia.com/support/.

Most common questions and problems are addressed there.

If you are unable to resolve your issue using our online technical support, please
use our online email form to send us a message. The form is at http://www.neto-
pia.com/support/contact_us.html.

Please provide the following information (for both the host and guest computers)
to assist us:

e Timbuktu Pro version and build number. Find this by selecting About Tim-
buktu Pro from the Help menu.

e Windows version, and any Service Packs installed.
e Error message or symptom.
e Stepsto reproduce the error.
e Relevant system information:
. PC manufacturer and model
o CPU speed
. Amount of RAM installed
. Video card manufacturer and model
. Video device driver version
° Sound card manufacturer and model
o Modem manufacturer and connection speed (if relevant)
[ ]

Type of connection: DSL, cable, ISDN, modem, etc.
Netopia’s web site is at http://www.netopia.com/.

When you are prepared, contact Netopia Customer Service on the Web, or by mail
or fax.

Online Technical Support

Technical notes and Frequently Asked Questions which answer the most com-
monly asked questions and offer solutions for many common problems are avail-
able 24 hours a day on our Company Web site at

http://www.netopia.com/support/
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Mail

Netopia, Inc.

Customer Service

Marketplace Tower

6001 Shellmound Street, 4th Floor
Emeryville, CA 94608

USA

Fax

(510) 420-7609

OUTSIDE OF THE UNITED STATES AND CANADA

If you are not located in the United States or Canada, you can get service locally
by contacting your nearest Netopia reseller or distributor. For a worldwide list of
our distributors, see our Internet information resources at
http://www.netopia.com/partners/.



APPENDIX A: KEYBOARD SHORTCUTS AND SERVICE
ICONS

Timbuktu Pro has a number of keyboard shortcuts that allow you to quickly ac-

cess connection tabs, menu options, and dialog box options without using your
mouse.

TIMBUKTU PRO KEYBOARD SHORTCUTS

Controlling a Macintosh computer is usually identical to controlling a Windows
computer. However, their keyboards are slightly different. The following table
shows how keys are mapped across platforms.

Note: If you type a keyboard shortcut while you are controlling a remote computer
and the Control window is active, the shortcut is carried out on the remote com-

puter only.
Windows Keys Macintosh Keys
ALT Option
CTRL Control
CTRL+ALT+DEL Control+Option+Delete
Right-click (on mouse) 3 (Command)
Window 3 (Command)

When you control a Macintosh, the Map Ctrl-> Cmd option appears on the system
menu in the screen-sharing window. (To open the system menu, click the Control
or Observe icon in the upper-left corner of the screen-sharing window.) If you en-
able this option, pressing CTRL on your Windows keyboard will send the equiva-

lent of a Command keystroke to the Macintosh.
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ICON LEGEND

2 10,15 4M

Timbuktu Pro’s service icons allow you to quickly identify its many services.

Icon Legend

[ 103

The Timbuktu Pro icon is displayed in the system tray on the Windows taskbar
whenever Timbuktu Pro is running. When a remote user connects to your com-
puter, the standard Timbuktu Pro icon alternates with a service icon indicating the
service in use. If the service icon is in color, a remote user is connected. If the ser-
vice icon is gray, the connection is closed.

Timbuktu Pro Icons

User Icon Meaning
@ A remote user is using the Send service with your computer.
'S..D A remote user is using the Exchange service with your com-
= puter.

A remote user is using the Observe service with your com-
puter.

A remote user is using the Control service with your com-
puter.

A remote user is using the Chat service with your computer.

A remote user is using the Intercom service with your com-
puter.

A remote user is using the Notify service with your computer.

A remote user is using the Invite service with your computer.




INDEX

A

accelerating performance 26, 32
accepting incoming calls 38
activity log 16, 96, 97
Activity Log option 97
Add Files to Send dialog box 63
Add Users and Groups dialog box 87
adding files to FlashNotes 63
adding Windows NT Users 86
address books 16, 55, 56
Address Books connection tab 15, 55
Address Books tab 55
addresses
changing properties 56
saving to address books 56
Admit Temporary Guest dialog box 92
Admit Temporary Guest option 92
admitting temporary guests 9o
Answer Automatically option (Notify Preferences)
73
Ask for Permission access
Log In dialog box 51
removing 91
requesting 51
Ask for Permission dialog box 90
Ask for Permission Users 79, 80, 90
allowing requests 82
asking for permission 51
granting access 91
granting services 91
Log In dialog box 51
requesting access 91

asking for permission 51
Log In dialog box 51
attended access 9o
authenticating
Registered Users 83
Windows NT Users 86
AutoScroll feature 66
autoscrolling 30

B
blanking the screen. See secure screen blanking
C
Capture Frame 28, 67, 70
enabling 28
starting session 70
using 70
changing

address book properties 56
Dial Direct preferences 38
general preferences 22
master password preferences 36
master passwords 36
Notify preferences 35
Observe/Control preferences 24
Registered User accounts 85, 89
Send preferences 33
Chat service 74
printing and saving transcripts 75
Chat window 74
chatting with remote users 74
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checking for remote users 94
checking the activity log 96
Clear Previous User Log option 95
clearing the user list 95
compatibility between versions of Timbuktu Pro
16
computer name 23
connecting to remote computers 47 to 61
Dial Direct connections 57
Connection Documents 59
changing properties 60
creating 59
connection tabs
Address Books tab 15, 55
Dial Direct tab 57,58
LDAP tab 52
Recent Connections tab 15, 55, 56, 57
TCP/IPtab 49, 56
connections
making 47
re-establishing 54
to a previously-used computer 54
using Dial Direct 57
using LDAP 52
using TCP/IP 49
using the Desktop Shortcut extension menu
59
Connections menu
Activity Log option 97
Admit Temporary Guest option 92
clearing users 95
disconnecting remote users 94
Control service 66
Capture Frame 28, 70
changing preferences 24
controlling access to your computer 44
controlling remote computers 66
screen-sharing window 67
Copy dialog box 57
Copy to Address Book button 56
copying files 65

Index [ 105

Create New Folder button 66
Create Shortcut on Desktop option 56
creating
desktop shortcuts 56
folders on remote computers 66
new address books 57
CTRL+ALT+DEL, sending to remote computers 71

D

default installation location 19
default service &g
defined 15
Desktop Shortcut extension menu 59
desktop shortcuts, creating 56
Dial Direct connection tab 57, 58
enabling 57
Dial Direct feature 14, 57
accepting incoming calls 38
changing preferences 38
establishing connections 58
Dial Direct tab (main Timbuktu Pro window) 57,
58
enabling 57
Dial Direct tab (Preferences dialog box) 38
dialog boxes. See individual dialog box names
disconnecting remote users 94
all users 94
disk space
protecting from usage 34
required for installation 16
displaying
the Logon Information dialog box 71
DOS sessions, full-screen 68

E

enabling connection tabs
Dial Direct tab 57
LDAP tab 52

Exchange service 65
creating new folders 66
subservices 91
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Exchange window 65 guests
exchanging files 65 disconnecting 94
Exit and Shut Down Timbuktu Pro option 21 monitoring 94
Exit option 21 temporary 92
exiting and shutting down Timbuktu Pro 21 Guests May Ask for Permission to Use Unchecked
exiting Timbuktu Pro 21 Services option 91, 92
F Guests tab (Security dialog box) 82
file extensions H

.tbk 57 hardware requirements 16

.tmb 60 Help 99
File menu

Exit and Shut Down Timbuktu Pro option 21 '

Exit option 21 icons 103

Open Address Book option 57 identifying your computer to remote users 23
files ignoring Notify requests 74

adding to FlashNotes 63 incoming calls, accepting 38

copying between computers 65 installation

saving from FlashNotes 64 default location 19

sending 62 hardware requirements 16

sending to another computer 63 pre-requisites 17
files received folder 34, 62 installing Timbuktu Pro 18
FlashNote window 62 Intercom service 76
FlashNotes 62 Intercom window 76

adding files 63 Internet Locator 14, 24, 49

display options 34 Invite service 77

files received folder 34, 62 Invite window 77

printing 64

saving 64 K

sending 62 keeping remote users out 94
folders keyboard shortcuts 102

creating on remote computers 66 L

See also files

launching Timbuktu Pro as a service 23

G LDAP connection tab 14, 52
general preferences, changing 22 enabling 52
General tab (Preferences dialog box) 22 LDAP option (Setup menu) 43
getting Help 99 LDAP Options dialog box 41
granting services to Guest Users 82 Advanced tab 42
Guest Users 79 General tab 42

defined 79 User’s Profile tab 43

granting services to 82



LDAP server
finding remote computers 52
setting your options 41
user profile 43
LDAP tab (main Timbuktu Pro window) 14, 52
enabling 52
location
default installation folder 19
files received folder 34, 62
Log In dialog box 51
logging on to a Windows 2000 computer 71
logging on to a Windows NT computer 71
Logging tab (Preferences dialog box) 39
Logon Information dialog box, displaying 71

M

main Timbuktu Pro window 16, 45
Address Books tab 55
Dial Direct tab 58
enabling Dial Direct tab 57
enabling LDAP tab 52
LDAP tab 52
Recent Connections tab 55, 56, 57
TCP/IP tab 56
making a Timbuktu Pro connection 47 to 61
making connections 47
Master Password tab (Preferences dialog box)
36,37
master passwords
changing 36
changing preferences 36
removing 37
setting 36
using 98
modem connections
changing preferences 38
Dial Direct connections 57
modifying. See changing
moving files between computers 65
MSI Installer 18
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N

Network Neighborhood integration 15
New Address Book dialog box 57
new features in Timbuktu Pro 10
Notify service 72
acknowledging requests 73
answering automatically 73
changing preferences 35
ignoring requests 74
setting message to be displayed 36
Notify tab (Preferences dialog box) 35
Notify window 72
NT Users tab 86
failure to appear 86

0]

Observe service 66
Capture Frame 28, 70
changing preferences 24

Observe/Control tab (Preferences dialog box) 25,
29

observing remote computers 66, 67

online Help 99

Open Address Book option 57

Open File dialog box 57

opening address books 57

P

password restrictions 85
Password Restrictions dialog box 85
Password Restrictions option 84
performance

accelerating 26, 32

protecting disk space 34
Preferences dialog box 22

Dial Direct tab 38

General tab 22

Logging tab 39

Master Password tab 36, 37

Notify tab 35



Preferences dialog box (continued)
Observe/Control tab 24, 25, 29
Send tab 33

Preferences option 22

preventing unauthorized access 98

previous users
activity log 96
clearing 95

printing
Chat sessions 75
FlashNotes 64
the activity log 97

protecting disk space 34

R

Recent Connections connection tab 15, 55, 56, 57
Recent Connections tab (main Timbuktu Pro

window) 15
Registered Users 79, 82

authenticating 83

changing 85

defined 80

Log In dialog box 51
Registered Users tab (Security dialog box) 83
remote computers

accessing through the Network

Neighborhood 15

connecting to 47 to 61

finding with LDAP 52

re-establishing a connection 54
remote connections, monitoring 94
Remote Control 66
remote users

checking for 94

controlling access 94

disconnecting 94
removing

master passwords 37

remote users 94
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requesting access as an Ask for Permission User
51,91
requesting notification 72
requesting permission 51, 91
Log In dialog box 51
requests for permission
allowing 82, 91
granting 91
preventing 91
requirements
compatibility 16
hardware 16
software 16
restricting access to your computer 44

S

saving chat sessions 75
saving files
files received folder 34
from FlashNotes 64
saving FlashNotes 64
screen blanking, secure. See secure screen
blanking
screen-sharing window 67
accelerating performance 26, 32
Capture Frame 28, 70
closing 67
scrolling automatically 30
system menu 68
troubleshooting 67
searching for remote computers 52
secure screen blanking 25 to 29
security 79
adding Windows NT Users 86
Capture Frame 28, 70
checking for remote users 94
controlling access to your computer 44
disconnecting remote users 94
granting services to Guest Users 82
keeping remote users out 94



security (continued)

master passwords 36, 37, 98

password restrictions 85

Registered Users 82
Security dialog box

Guests tab 82

NT Users tab 86, 89, 90

Registered Users tab 83
Send service 62

changing preferences 33

files received folder 62

FlashNote display options 34

printing FlashNotes 64

saving FlashNotes 64
Send tab (Preferences dialog box) 33
sending files to another computer 63
sending messages and files 62
services

Chat 74

Control 66

Exchange 65, 91

Intercom 76

Invite 77

Notify 72

Observe 66

Send 62

setting Notify messages 36
setting password restrictions 85
setting up Timbuktu Pro 20
Setup menu

LDAP option 43

Preferences option 22

Security option 82, 83, 89, 90
shortcut menu 13
shortcuts, keyboard 102
shutting down Timbuktu Pro 21
software requirements 16
speaking to remote users 76
Start Timbuktu Pro as a Service option

(Preferences dialog box) 23
starting Timbuktu Pro 20
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startup, launching Timbuktu Pro as a service 23
system menu 68, 95

T

tabs. See connection tabs
.tbk file extension 57
TCP/IP address 46
TCP/IP connection tab 14, 49, 56
making a new connection 49
TCP/IP tab 49
TCP/IP tab (main Timbuktu Pro window) 14, 56
making a new connection 49
temporary guests 79, 92
admitting 90, 92
Timbuktu computer name 23
Timbuktu Pro
exiting 21
features 10
activity log 16, 96
address books 16, 55

comprehensive multi-level security 16,

79

cross-platform connections 16
My Network Places integration 15
Network Neighborhood integration 15
Remote Control 12, 66
secure screen blanking 28
sending messages 15
service shortcuts 15, 59

installing 17, 18

introduction 7

keyboard shortcuts 102

launching as a service 23

main window 45

new features 10

security 79

setting up 20

shutting down 21

startup 20

types of users 79

uninstalling 19



Timbuktu Pro Connection Documents 15, 59
changing properties 60
creating 59

Timbuktu Pro icons 103

Timbuktu Pro window 16, 45
Address Books tab 55
Dial Direct tab 58
enabling Dial Direct tab 57
enabling LDAP tab 52
LDAP tab 52
Recent Connections tab 55, 56, 57
TCP/IPtab 56

Timbuktu Pro, new features 10

.tmb file extension 60

transcripts of Chat sessions 75

U

uninstalling Timbuktu Pro 19
Use Accelerated Capture option (Preferences
dialog box) 26, 32

User’s Profile tab (LDAP Options dialog box) 43

using the address books 55

w

windows
Activity Log window 97
Chat window 74
Exchange window 65
FlashNote window 62
Intercom window 76
Invite window 77
main Timbuktu Pro window 16
Notify window 72
screen-sharing 67
Windows 2000 Users. See Windows NT Users
Windows NT Event Log 98
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Windows NT Users 79, 80

adding 86
authenticating 86
changing 89
defined 80
defining 86

Windows NT/Windows 2000

logging on 71
sending CTRL+ALT+DEL 71

Windows NT/Windows 2000 Logon Information

dialog box, displaying 71
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